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Safety
Your printer and the recommended supplies were designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued and safe operation of
your Xerox printer.

This chapter contains:

• Notices and Safety... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

• Electrical Safety ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

• Operational Safety... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
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• Environmental, Health, and Safety Contact Information... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18



Notices and Safety
Before operating your printer, read the following instructions carefully. To ensure the continued safe
operation of your printer, refer to these instructions.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These
requirements include safety agency evaluation and certification, and compliance with
electromagnetic regulations and established environmental standards.
The safety and environment testing and performance of this printer was verified with Xerox®
materials only.

Note: Unauthorized alterations, which can include the addition of new functions or the
connection of external devices, can affect the printer certification. For more information,
contact your Xerox representative.
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Electrical Safety

GGeenneerraall GGuuiiddeelliinneess
WARNING:

• Do not push objects into slots or openings on the printer. Touching a voltage point or
shorting out a part can result in fire or electric shock.

• Unless you install optional equipment and are instructed to do so, do not remove the covers
or guards that are fastened with screws. Before you perform these installations, power off
the printer. When you remove covers and guards to install optional equipment, disconnect
the power cord. Except for user-installable options, there are no parts that you can maintain
or service behind these covers.

WARNING: The following are hazards to your safety:

• The power cord is damaged or frayed.

• Liquid is spilled into the printer.

• The printer is exposed to water.

• The printer emits smoke, or the surface is unusually hot.

• The printer emits unusual noise or odors.

• The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Power off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

PPoowweerr CCoorrdd
Use the power cord supplied with your printer.

• Do not use an extension cord, or remove or modify the power cord plug.

• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have
a ground connection terminal.

WARNING: To avoid the potential of electrical shock, ensure that the printer is
grounded properly. If misused, electrical devices can be hazardous.

• Verify that the printer is plugged into an outlet that provides the correct voltage and power. If
necessary, review the electrical specification of the printer with an electrician.

• Do not place the printer in an area where people can step on the power cord.

• Do not place objects on the power cord.

• Replace a frayed or worn power cord.
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• To avoid electrical shock and damage to the cord, grasp the plug when you unplug the power cord.

• Ensure that the electrical outlet is near the printer and easily accessible.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is
necessary to disconnect all electrical power from the printer, disconnect the power cord from the
electrical outlet.

EEmmeerrggeennccyy PPoowweerr OOffff
If any of the following conditions occur, power off the printer immediately. Disconnect the power cord
from the electrical outlet. To correct the problem, contact an authorized Xerox service representative
if any of these conditions occur:

• The equipment emits unusual odors or makes unusual noises.

• The power cable is damaged or frayed.

• A wall panel circuit breaker, fuse, or other safety device was tripped.

• Liquid is spilled into the printer.

• The printer is exposed to water.

• Any part of the printer is damaged.

LLaasseerr SSaaffeettyy
This printer complies with laser device performance standards set by governmental, national, and
international agencies and is certified as a Class 1 Laser Product. Because the beam is enclosed
completely during all modes of customer operation and maintenance, the printer does not emit
hazardous light.

Laser Warning: Use of controls, adjustments, or performance of procedures other than those
items specified in this manual can result in hazardous radiation exposure.
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Operational Safety
Your printer and supplies were designed and tested to meet strict safety requirements. These
requirements include safety agency examination, approval, and compliance with established
environmental standards.
Your attention to the following safety guidelines helps to ensure the continued, safe operation of your
printer.

OOppeerraattiioonnaall GGuuiiddeelliinneess
• When the printer is printing, do not remove any paper trays.

• When the printer is printing, do not open the doors.

• When the printer is printing, do not move it.

• Keep hands, hair, neckties, and so on, away from the printer exit and feed rollers.

• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

Hot Warning: The metallic surfaces in the Fuser area are hot. Use caution when you
remove paper jams from this area and avoid touching any metallic surfaces.

• Do not override any electrical or mechanical interlock devices.

• Do not attempt to remove paper that is jammed deeply inside the printer. Power off the printer
promptly, and then contact your local Xerox representative.

• To avoid a tip hazard, do not push or move the device when all paper trays are extended.

OOzzoonnee RReelleeaassee
This printer produces ozone during regular operation. The amount of ozone produced depends on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.
For more information, contact your local Xerox representative, or go to www.xerox.com/environment_
europe.
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PPrriinntteerr LLooccaattiioonn
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight.

To find the weight for your printer configuration, refer to Physical Specifications.

• Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

• Place the printer in an area where there is adequate space for operation and servicing.

• Place the printer in a dust-free area.

• Do not store or operate the printer in a hot, cold, or humid environment.

• Do not place the printer near a heat source.

• To avoid exposure to light-sensitive components, do not place the printer in direct sunlight.

• Do not place the printer where it is exposed directly to the cold air flow from an air-conditioning
system.

• Do not place the printer in locations that are susceptible to vibrations.

• For optimum performance, use the printer at the elevations specified in Elevation.

PPrriinntteerr SSuupppplliieess
• Use supplies that are designed for your printer. The use of unsuitable materials can cause poor

performance and a possible safety hazard.

• Follow all warnings and instructions marked on, or supplied with, the printer, options, and supplies.

• Store all consumables in accordance with the instructions provided on the package or container.

• Keep all consumables away from the reach of children.

• Do not throw toner cartridges or drum cartridges into an open flame.

• When handling cartridges, such as toner cartridges, avoid skin and eye contact with the toner. Eye
contact with toner can cause irritation and inflammation. Do not attempt to disassemble the
cartridge, which can increase the risk of skin and eye contact with the toner.
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Maintenance Safety
• Do not attempt to perform any maintenance procedure that is not described specifically in the

documentation supplied with your printer.

• Clean the printer with a dry, lint-free cloth only.

• Do not burn any consumables or routine maintenance items.

• For information on Xerox supplies recycling programs, go to www.xerox.com/gwa.

WARNING: Do not use aerosol cleaners. When used on electromechanical equipment, aerosol
cleaners can cause explosions or fires.
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Printer Symbols
Symbol Description

Warning:
Indicates a hazard that can cause serious injury or death if not avoided.

Laser Warning
Indicates that use of controls, adjustments, or performance of procedures other than
those items specified in this manual can result in hazardous radiation exposure
.

Hot Warning:
Hot surface on or in the printer. Use caution to avoid personal injury.

Caution:
Indicates a mandatory action to take to avoid damage to the property.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

Do not burn the drum cartridges.
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Symbol Description

Do not touch the part or area of the printer.

Do not use paper attached with paper clip or any other form of binding clip.

Do not use paper attached with one or more staples.

Do not use folded, creased, curled, or wrinkled paper.
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Environmental, Health, and Safety Contact
Information
For more information on Environment, Health, and Safety in relation to this Xerox printer and
supplies, contact Europe: EHS-Europe@xerox.com
For printer safety information in Europe, go to www.xerox.com/environment_europe.
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Parts of the Printer
FFrroonntt VViieeww

1. Optional Feeder Tray 2 with 250-Sheet
Capacity

2. Tray 1 with 250-Sheet Capacity

3. Front Door Cover

4. Output Tray

5. Touch Screen

6. Control Panel

7. Document Feeder Top Cover

8. Document Feeder Input Tray

9. Document Feeder Output Tray

10. Side Cover Release Lever

11. Bypass Tray

12. USB Port

RReeaarr VViieeww
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1. Power Receptacle

2. USB Port, B-Type

3. Ethernet Connection

4. USB Port, A-Type

5. Fax Line Connection, option

IInntteerrnnaall CCoommppoonneennttss

1. Toner Cartridge

2. Drum Cartridge

3. Document Glass

4. Document Glass Cover

5. Document Feeder

DDooccuummeenntt FFeeeeddeerr
The document feeder is a standard feature of this printer.
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UUssiinngg tthhee DDooccuummeenntt FFeeeeddeerr

• The maximum feeder capacity is approximately 100 sheets of 80 g/m² paper.

• For 2-sided pages, the document feeder accepts paper weights from 60–128 g/m² (16–34 lb.).

• The document feeder accepts these paper sizes:

– For 1-sided pages: Paper that ranges from 140 x 130 mm (5.5 x 5 in.) through 297 x 432 mm
(11.7 x 17 in.)

– For 2-sided pages: Paper that ranges from 148 x 210 mm (5.8 x 8 in.) through 297 x 432 mm
(11.7 x 17 in.)

1. Insert the original documents face up in the document feeder, so that the first page is facing you.

2. Adjust the paper guides so that they fit against the edges of the original documents.

DDooccuummeenntt FFeeeeddeerr GGuuiiddeelliinneess
When you load original documents into the document feeder, follow these guidelines.

• Insert originals face up, with the top of the page entering the feeder first.

• Place loose sheets of paper only in the document feeder.

• Adjust the paper guides so that they fit against the edges of the original documents.

• Insert paper in the document feeder only when ink on the paper is dry.

• Do not load original documents above the MAX fill line.
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UUssiinngg tthhee DDooccuummeenntt GGllaassss

1. Lift the document cover.

2. Place the first page face down in the upper-left corner of the document glass.

3. Align the original documents to the matching paper size printed on the edge of the glass.

DDooccuummeenntt GGllaassss GGuuiiddeelliinneess
The document glass accommodates original document page sizes up to 297 x 432 mm (11.69 x 17
in.). Use the document glass to copy or scan the following types of originals documents:

• Paper with paper clips or staples attached

• Paper with wrinkles, curls, folds, tears, or notches

• Carbonless paper or items other than paper such as cloth or metal

• Books

CCoonnttrrooll PPaanneell
The control panel consists of a touch screen, an alphanumeric keypad, and buttons to control the
functions available on the Xerox device. You can use the control panel for these tasks:

• View the current operating status of the device.

• Access printer features.

• Access reference materials.

• Access the Tools and Setup menus.

• Access the Troubleshooting menus and videos.

• View status messages about paper-tray levels and supplies.
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• View any errors or warnings that occur on the device.

Item Name Description

1 Machine Status button This button displays the status of the printer on the touch
screen.

2 Job Status button This button displays all active, secure, or completed jobs
on the touch screen.

3 Services button This button returns you to the active service from the Job
Status or Machine Status screens, or to a preset service.

4 Services Home button This button provides access to printer features such as
copy, scan, and fax on the touch screen.

5 Touch screen The touch screen displays information and provides
access to printer functions.

6 Log In/Out button This button provides access to password-protected
features.

7 Self Help (?) button This button displays information about the current
selection on the touch screen.

8 Language button This button changes the touch screen language and
keyboard settings.

9 Power Saver button This button allows the printer to enter and exit the low-
power mode, and power down the printer.

10 Clear All button This button clears previous and changed settings for the
current selection. To reset all features to their default
settings and clear existing scans, press this button twice.

11 Stop button This button stops the current job temporarily. To cancel or
resume your job, follow the onscreen instructions.

12 Start button This button starts the selected copy, scan, fax, or Print
From job, such as Print from USB.

13 Interrupt button This button pauses the current job to run a more urgent
print, copy, or fax job.

14 Dial Pause button This button inserts a pause in a telephone number when
the device transmits a fax.
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Item Name Description

15 C clear button This button deletes numeric values or the last digit
entered using the alphanumeric keys.

16 Alphanumeric keypad The keypad allows you to enter text and fax telephone
numbers.
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Information Pages
Your printer has a set of information pages that you can access from the control panel touch screen.
The information pages include Customer Support access, installed options, and more.

AAcccceessssiinngg aanndd PPrriinnttiinngg tthhee IInnffoorrmmaattiioonn PPaaggeess
To access the full list of information pages for your printer:

1. At the printer control panel, press the Self Help (?) button.

A list of information pages that you can print appears.

2. To scroll the list of available pages, touch and drag your finger up or down the menu. Touch the
required page, then touch Print.

Note: To print all the information pages, touch All Information Pages, then touch Print.

3. To return to the Home screen, touch (X).

PPrriinnttiinngg tthhee CCoonnffiigguurraattiioonn RReeppoorrtt
You can print the Configuration Report at the printer control panel. The Configuration Report provides
product information, including installed options, network settings, port setup, tray information, and
more.

Note: To deactivate automatic printing of a Configuration Report, refer to the System
Administrator Guide at www.xerox.com/office/B1022_B1025docs.

1. At the printer control panel, press the Help button.

2. Touch System Configuration.

3. Touch Print.

4. To return to the Services Home menu, press the Services Home button.
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System Administration Features
For details about system administrator responsibilities, refer to the System Administrator Guide at
www.xerox.com/office/B1022_B1025docs.

XXeerrooxx®® CCeennttrreeWWaarree®® IInntteerrnneett SSeerrvviicceess
Xerox® CentreWare® Internet Services is the administration and configuration software installed on
the embedded Web server in the printer. Xerox CentreWare Internet Services software allows you to
configure and administer the printer from a Web browser.
Xerox® CentreWare® Internet Services requires:

• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

• TCP/IP and HTTP enabled in the printer.

• A network-connected computer with a Web browser that supports JavaScript.

1. At your computer, open a Web browser.

2. In the address field, type the IP address of your Xerox device.

3. Press Enter or Return.

LLooccaattiinngg tthhee IIPP AAddddrreessss ooff tthhee PPrriinntteerr
You can view the IP address of your printer on the control panel or on the Configuration Report.

To install print drivers for a network-connected printer, you need the IP address of your printer. Use
the IP address to access and configure any printer settings in Xerox® CentreWare® Internet Services.
To view the IP address of the printer on the control panel:

1. At the printer control panel, press theMachine Status button.

2. TouchMachine Information.
If the system administrator set the Display Network Settings to display the IP address, it appears
at the top of the Machine Information list.

Note: If the IP address does not appear, print the Configuration Report, or contact your
system administrator.

3. To close the window, touch X.
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AAuuttoommaattiicc DDaattaa CCoolllleeccttiioonn
The Xerox printer collects data automatically, then transmits the data to a secure off-site location.
Xerox, or a designated service provider, uses the data to support and service the printer, or for billing,
supplies replenishment, or product improvement.
Data transmitted automatically can include product registration, meter readings, supplies levels,
printer configuration and settings, software version, and problem or fault-code data. Xerox cannot
read, view, or download the content of your documents that reside on or pass through your printer or
any of your information-management systems.

Note: System Administrator credentials are required to disable SMart eSolutions.
To disable automatic data collection:

1. At your computer, open a Web browser.

2. In the address field, type the IP address of your Xerox device.

3. Press Enter or Return.

4. On the Xerox® CentreWare® Internet Services Welcome page for your Xerox device, for
automated services, select the link in the webpage note.

The SMart eSolutions Setup page opens in Xerox® CentreWare® Internet Services. From this
page, your system administrator can disable SMart eSolutions. To disable the feature, click Not
Enrolled→Apply.

MMaaiinntteennaannccee AAssssiissttaanntt
Your printer includes a built-in diagnostic capability allowing you to send diagnostic information
directly to Xerox. Maintenance Assistant is a remote diagnostic tool that offers a fast way to resolve
potential issues, receive assistance, and automate the troubleshooting or repair process.

EEnnaabblliinngg MMaaiinntteennaannccee AAssssiissttaanntt
Before you begin:
If your network uses a proxy server, to ensure that the printer can connect to the Internet, configure
the printer Proxy Server settings.

1. At your computer, open a Web browser.

2. In the address field, type the IP address of the printer.

3. Press Enter or Return.

4. From the Xerox® CentreWare® Internet Services for your Xerox device, click Status→SMart 
eSolutions.

5. From Smart eSolutions, clickMaintenance Assistant.

6. To send status information to Xerox, click Start an Online Troubleshooting Session at www.
xerox.com.

7. After Xerox® CentreWare® Internet Services sends the printer data, your browser redirects to
www.xerox.com, then starts your online troubleshooting session.
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VViieewwiinngg BBiilllliinngg aanndd UUssaaggee IInnffoorrmmaattiioonn
Billing and printer usage information appears on the Billing Meters information screen. The
impression counts shown onscreen are used for billing.
For details on viewing the billing information, refer to Viewing Billing Meter Information in the
Maintenance chapter.
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More Information
You can obtain more information about your printer from these sources:

Resource Location

Installation Guide Packaged with the printer and can be downloaded at
www.xerox.com/office/B1022_B1025docs

Other documentation for your printer
www.xerox.com/office/B1022_B1025docs

Technical support information for your
printer, including online technical
support, Online Support Assistant, and
print driver downloads.

www.xerox.com/office/B1022_B1025support

Information Pages
Accessing and Printing the Information Pages

Information about menus or error
messages

Press the control panel Self Help (?) button.

Order supplies for your printer
http://www.support.xerox.com

Local Sales and Support Center
www.xerox.com/office/worldcontacts

Printer registration
www.xerox.com/office/register

Xerox® Direct online store
www.direct.xerox.com/
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Installation and Setup
Refer to:

• Installation Guide packaged with your printer.

• System Administrator Guide at www.xerox.com/office/B1022_B1025docs.

IInnssttaallllaattiioonn aanndd SSeettuupp OOvveerrvviieeww
Before printing:

• Ensure that your computer and the printer are plugged in, powered on, and connected.

• Configure the initial settings of the printer.

• On your computer, install the driver software and utilities.

You can connect to your printer directly from your computer using a USB device, or connect to a
network using an Ethernet cable or wireless connection. Hardware and cabling requirements vary for
the different connection methods. Routers, network hubs, network switches, modems, Ethernet cables,
and USB cables are not included with your printer and must be purchased separately. Xerox
recommends an Ethernet connection because, typically, it is faster than a USB connection, and it
provides access to Xerox® CentreWare® Internet Services.

Note: If the Software and Documentation disc is not available, download the latest drivers at
www.xerox.com/office/B1025drivers.

SSeelleeccttiinngg aa LLooccaattiioonn ffoorr tthhee PPrriinntteerr
• Select a dust-free area with temperatures from 10–30° C (50–86° F), and a relative humidity of

20–80%.

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a
cold room can cause condensation inside the printer, and can interfere with image
transfer.

• Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of
the printer. The printer must be horizontal with all four feet in solid contact with the surface. To
find the weight for your printer configuration, refer to Physical Specifications.

• Select a location with adequate clearance to access supplies and to provide proper ventilation. To
find the clearance requirements for your printer, refer to Clearance Requirements.

• After positioning the printer, you are ready to connect it to the power source and computer or
network.

CCoonnnneeccttiinngg tthhee PPrriinntteerr

SSeelleeccttiinngg aa CCoonnnneeccttiioonn MMeetthhoodd
The printer can be connected to your computer using a USB cable or an Ethernet cable. The method
you select depends on how your computer is connected to the network. A USB connection is a direct
connection and is the easiest to set up. An Ethernet connection is used for networking. If you are
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using a network connection, ensure that you understand how your computer is connected to the
network. For details, refer to About TCP/IP and IP Addresses.

Note:

• Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or driver type.

• Hardware and cabling requirements vary for the different connection methods. Routers,
network hubs, network switches, modems, Ethernet cables, and USB cables are not included
with your printer and must be purchased separately.

Wired Network

If your computer is connected to an office network or home network, use an Ethernet cable to
connect the printer to a network port. Ethernet networks can support many computers, printers, and
devices simultaneously. In most cases, an Ethernet connection is faster than USB and provides direct
access to printer settings using Xerox® CentreWare® Internet Services.

Wireless Network

If your network includes a wireless router or wireless access point, you can connect the printer to the
network with a wireless connection. A wireless network connection provides the same access and
services as a wired connection provides. A wireless network connection is typically faster than USB
and allows direct access to the setting of the printer using Xerox® CentreWare® Internet Services.

USB

If you connect the printer to one computer and do not have a network, use a USB connection. A USB
connection offers fast data speeds, but typically not as fast as an Ethernet connection. A USB
connection does not provide access to Xerox® CentreWare® Internet Services.

Telephone

To send and receive faxes, a multifunction printer requires a direct connection to a dedicated
telephone line.

CCoonnnneeccttiinngg tthhee PPrriinntteerr ttoo aa WWiirreedd NNeettwwoorrkk
Use a Category 5 or higher Ethernet cable to connect the printer to the network. An Ethernet network
is used for one or more computers and supports many printers and systems simultaneously. An
Ethernet connection provides direct access to printer settings using Xerox® CentreWare® Internet
Services.
To connect the printer:

1. Ensure that the printer is powered off.

2. Connect one end of a Category 5 or higher Ethernet cable to the Ethernet port on the printer.
Connect the other end of the Ethernet cable to a correctly configured network port on a hub or
router.

3. Connect the power cord to the printer, then plug the cord into an electrical outlet.
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4. Power on the printer.
For details on configuring network settings, refer to the System Administrator Guide at www.
xerox.com/office/B1022_B1025docs.

5. Enter the printer IP address, or set Xerox® CentreWare® Internet Services to discover the network
IP address of the printer automatically.

CCoonnnneeccttiinngg tthhee PPrriinntteerr ttoo aa WWiirreelleessss NNeettwwoorrkk
If you purchased a Wireless Network Adapter, you can connect the device to a wireless network. If
the device is connected to a wired network, you can configure wireless settings using Xerox®
CentreWare® Internet Services. For details on configuring wireless network settings, refer to the
System Administrator Guide at www.xerox.com/office/B1022_B1025docs.

Note: Before configuring wireless network settings, install the Xerox Wireless Network Adapter
Kit. For information, refer to the Hardware Install and Setup instructions that are included with
the kit.

CCoonnnneeccttiinngg ttoo aa CCoommppuutteerr UUssiinngg UUSSBB
To connect using USB, you need Windows 7, Windows 8 or later, Windows Server 2008 or later, or
Macintosh OS X version 10.9 or later.
To connect the printer to the computer using a USB cable:

1. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the rear left of the printer.

2. Connect the A end of the USB cable to the USB port on the computer.

3. If the Windows Found New Hardware Wizard appears, select Cancel.

4. Install the print drivers. For details, refer to Installing the Driver Software.

CCoonnnneeccttiinngg ttoo aa TTeelleepphhoonnee LLiinnee
Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or driver type.

1. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on
the back of the printer.

2. Connect the other end of the RJ11 cable to an operating telephone line.

3. Enable and configure the Fax functions.

For details, refer to the System Administrator Guide at www.xerox.com/office/B1022_B1025docs.
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PPoowweerriinngg tthhee PPrriinntteerr OOnn oorr OOffff
Powering On the Printer
After you plug in the power cord to the printer and the wall outlet, the printer automatically powers
on.

Note: If the printer does not automatically power on, press the Power Save button to power on
the printer.

Powering Off the Printer

• The main power switch controls the power to the printer.

• To initiate an orderly shutdown of the printer electronic components, and to power off the printer,
press the Power Saver button.

• On the control panel screen, select the Power Down option.

Note:When all control panel lights are off, the printer power-off sequence is complete.

• If the power-off sequence is not functioning properly, unplug the power cord from the wall outlet,
then plug in the power cord.

Caution:

• To prevent a printer malfunction, perform the control panel shutdown first.

• If the power-off sequence is not functioning properly, unplug the power cord from the
printer, then plug in the power cord. The printer automatically powers on.

Note: If the printer does not power on again, press the Power Save button
to power on the printer.

Note:When all control panel lights are off, the printer power-off sequence is complete.

CCoonnffiigguurriinngg NNeettwwoorrkk SSeettttiinnggss

AAbboouutt TTCCPP//IIPP aanndd IIPP AAddddrreesssseess
Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network.
Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a
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network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour
does not require printers or computers to have IP addresses.
With TCP/IP protocols, each printer and computer requires a unique IP address. Many networks, cable,
and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server
automatically assigns an IP address to every computer and printer on the network that is configured
to use DHCP.
If you use a cable or DSL router, for information on IP addressing, refer to the documentation for your
router.

EEnnaabblliinngg tthhee PPrriinntteerr ffoorr SSccaannnniinngg
If the printer is connected to a network, you can scan to any of the following locations.

• FTP

• SMB

• HTTP

• HTTPS

• SFTP

• An email address

• A shared folder on your computer

For details, refer to Xerox® CentreWare® Internet Services.

Note: If your printer is connected using a USB cable, you cannot scan to an email address or a
network location, such as a shared folder on your computer.

For details, refer to the System Administrator Guide at www.xerox.com/office/B1022_B1025docs.

PPoowweerr SSaavveerr MMooddee
Power Saver mode reduces power consumption when the printer is left idle for a specified period.

PPoowweerr SSaavveerr LLeevveellss
There are two power-saver levels:

• Power Saver Mode 1 Timer: This mode ends your current session and puts the printer in a sleep
mode.

• Power Saver Mode 2 Timer: This mode powers off the printer.

EExxiittiinngg PPoowweerr SSaavveerr MMooddee
The printer exits Power Saver mode automatically when any of the following events occur:

• Pressing a button on the control panel

• Touching the UI screen

• Receiving data from a connected device
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• Opening any door or cover on the printer

SSeettttiinngg tthhee PPoowweerr SSaavveerr MMooddee TTiimmeerrss aatt tthhee CCoonnttrrooll PPaanneell
Note: System administrator credentials are required to perform the following procedure.

1. At the printer control panel, press theMachine Status button.

2. Touch Device Settings→General→Power Saver Timer Adjustment.

3. To select the appropriate time, touch the Arrow icons, or enter a value using the numeric keypad.
• Specify how long the printer remains idle before it changes from ready mode to low-power

mode.
• Specify how long the printer remains idle before automatically changing from low-power

mode to sleep mode.

4. Touch OK.

IInnssttaalllliinngg tthhee DDrriivveerr SSooffttwwaarree
Before you install driver software, verify that the printer is plugged in, powered on, connected
correctly, and has a valid IP address.
If you cannot find the IP address, refer to Locating the IP Address of the Printer.
Download the latest drivers at www.xerox.com/office/B1022_B1025drivers.

OOppeerraattiinngg SSyysstteemm RReeqquuiirreemmeennttss
• Windows Vista, Windows 7, Windows 8, Windows 8.1, Windows 10, Windows Server 2008,

Windows Server 2008 R2, and Windows Server 2012

• Macintosh OS X version 10.9 and later

• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface. For details, refer to www.xerox.com/office/B1025drivers.

IInnssttaalllliinngg DDrriivveerrss aanndd UUttiilliittiieess ffoorr WWiinnddoowwss
To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver.

To install the print and scan driver software:

1. Insert the Software and Documentation disc into the appropriate drive on your computer. The
installer starts automatically.
If the installer does not start automatically, navigate to the drive, then double-click the Setup.exe
installer file.

2. To change the language, click Language.

3. Select your language, then click OK.

4. Click Install Drivers→Install Print and Scan Drivers.

5. To accept the license agreement, click I Agree.

6. From the list of discovered printers, select your printer, then click Next.

7. If your printer does not appear in the list of discovered printers, click Extended Search.
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8. If your printer still does not appear in the list of discovered printers, and you know the IP address,
choose one of the following:
• At the top of the window, click the Network Printer icon, then enter the IP address or the DNS

name of the printer.
• Click Search. From the list of discovered printers, select your printer, then click Next.

9. If the printer still does not appear in the list of discovered printers, and you do not know the IP
address:

a. Click Advanced Search.

b. If you know the gateway address and subnet mask, click the top button, then enter the
addresses into the Gateway and Subnet Mask fields.

c. If you know the address of another printer on the same subnet, click the middle button, then
enter the address in the IP Address field.

d. Click Search.

e. From the list of discovered printers, select your printer, then click Next.

Note:When the printer appears in the Discovered Printers window, the IP address appears.
Record the IP address for future use.

10. Select the required driver.

11. Click Install.

12. If the installer prompts you for the IP address, enter the IP address of the printer.

13. If the installer prompts you to restart your computer, to complete the installation of the drivers,
click Restart.

14. To complete the installation, click Finish.

IInnssttaalllliinngg PPrriinntt DDrriivveerrss ffoorr MMaacciinnttoosshh OOSS XX VVeerrssiioonn 1100..99 aanndd LLaatteerr
Use this procedure to install the Xerox print driver to access all features of your printer.

To install the print driver software:

1. Download the print driver from www.xerox.com/office/B1022_B1025drivers.

2. To view the .dmg file for your printer, on your desktop, click the disc icon.

3. Open the .dmg file, then navigate to the appropriate installer file for your operating system.

4. To begin installation, open the Installer package file.

5. To acknowledge the warning and introductory messages, click Continue. Click Continue again.

6. To accept the license agreement, click Continue, then click Agree.

7. To accept the current installation location, click Install, or select another location for the
installation files, then click Install.

8. Enter your password, then click Install Software.

9. In the list of discovered printers, select your printer, then click Continue. If your printer does not
appear in the list of discovered printers:

a. Click the Network Printer icon.

b. Type the IP address of your printer, then click Continue.
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c. In the list of discovered printers, select your printer, then click Continue.

10. To accept the print queue message, click Continue.

11. To accept the installation success message, click Close.

12. To verify that the print driver recognizes the installed options:

a. From the Apple menu, click System Preferences→Printers and Scanners.

b. Select the printer from the list, then click Options & Supplies.

c. Click Options.

d. Confirm that all the options installed on the printer appear correct.

e. If you change settings, click OK. Close the window, then exit System Preferences.

IInnssttaalllliinngg SSccaann DDrriivveerrss ffoorr MMaacciinnttoosshh
To install the scan driver software:

1. To download the latest driver, go to www.xerox.com/office/B1025drivers.

2. Download the appropriate package for your operating system.

3. To view the .dmg file for your printer, on your desktop, click the disc icon.

4. Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your
operating system.

5. Open the Scan Installer package file.

6. To acknowledge the warning and introductory messages, click Continue.

7. To accept the license agreement, click Continue, then click Agree.

8. Click Continue again.

9. Enter your password, then click OK.

10. If prompted to close other installations, click Continue Installing.

11. To restart, click Log Out.

IInnssttaalllliinngg PPrriinntt DDrriivveerrss ffoorr UUNNIIXX aanndd LLiinnuuxx
Note:

• To install UNIX print drivers on your computer, root or superuser privileges are required.

• An Internet connection is required to install print drivers.

To install Linux drivers, perform the following steps, then select Linux instead of UNIX for the
operating system and package.
To install the print driver software:

1. On the printer control panel, for the IP address, do the following:

a. Allow the printer to set up a DHCP address.

b. Print the Configuration Report, and save it for later reference.
For information on how to print the Configuration Report, refer to Printing the Configuration
Report.
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c. From the Configuration Report, verify that the TCP/IP protocol is enabled and that the
network cable is installed.

2. At your computer, do the following:

a. From the print driver website for your printer, select your printer model.

b. From the Operating System menu, select UNIX, then click Go.

c. Select the appropriate package for your operating system.

d. To begin the driver download, click the Start button.

3. In the notes below the driver package that you selected, click the Installation Guide link, then
follow the installation instructions.

OOtthheerr DDrriivveerrss
The following drivers are available for download:

• The Xerox® Global Print Driver works with any printer on your network, including those printers
made by other manufacturers. At installation, the driver configures itself for your individual
printer.

• The Xerox® Mobile Express Driver works with any printer available to your computer that supports
standard PostScript. Each time you select Print, the driver configures itself for the correct printer. If
you travel frequently to the same sites, you can save your favorite printers in that location, and
the driver saves your settings.

Download the drivers at www.xerox.com/office/B1025drivers.

IInnssttaalllliinngg tthhee PPrriinntteerr aass aa WWeebb SSeerrvviiccee oonn DDeevviicceess
The Web Services on Devices (WSD) application allows you to discover and access a remote device
and associated services across a network. WSD supports device discovery, control, and use.

IInnssttaalllliinngg aa WWSSDD PPrriinntteerr UUssiinngg tthhee AAdddd DDeevviiccee WWiizzaarrdd
To install a Web Services on Device (WSD) printer, use the Add Device Wizard.

1. At your computer, click Start, then select Devices and Printers.

2. To launch the Add Device Wizard, click Add a Device.

3. In the list of available devices, select the device that you want to use, then click Next.

Note: If your printer does not appear in the list, click the Cancel button. To add the WSD
printer to the device list, use the Add Printer Wizard. For information, refer to Installing a
WSD Printer Using the Add Printer Wizard.

4. Click Close.

IInnssttaalllliinngg aa WWSSDD PPrriinntteerr UUssiinngg tthhee AAdddd PPrriinntteerr WWiizzaarrdd
To install a Web Services on Device (WSD) printer, use the Add Printer Wizard.

1. At your computer, click Start, then select Devices and Printers.

2. To launch the Add Printer Wizard, click Add a Printer.
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3. Click Add a network, wireless, or Bluetooth printer.

4. In the list of available devices, select the device that you want to use, then click Next.

5. If your printer does not appear in the list, click The printer that I want is not listed.

6. Select Add a printer using a TCP/IP address or hostname, then click Next.

7. For the Device type, selectWeb Services Device.

8. In the Hostname or IP address field, enter the printer IP address. Click Next.

9. Select an option for sharing the printer with others in your network.

10. To identify the printer for sharing, enter a share name, location, and comments. Click Next.

11. To set the printer as the default, select an option. To test the connection, click Print a Test Page.

12. Click Finish.

PPrriinnttiinngg ffrroomm aa DDeevviiccee UUssiinngg MMoopprriiaa oorr GGooooggllee CClloouudd
PPrriinntt
The following allow you to print without requiring a print driver:

Mopria
Mopria is a software feature that enables users to print from mobile devices without requiring a
print driver. You can use Mopria to print from your mobile device to Mopria-enabled printers.

Google Cloud Print
Google Cloud Print allows you to print documents from an Internet-connected device without
using a print driver. You can send documents stored in the cloud, on a personal computer, a tablet,
or smartphone to the printer from anywhere.

For more information, refer to the System Administrator Guide at www.xerox.com/office/B1022_
B1025docs.
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Using the Services
This chapter contains:
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The Services are a gateway to the features and functions of your device. There are standard Services
already installed and ready to use on the device. There are also Services that are hidden when your
device is used for the first time. Set up and customize the Services using Xerox® CentreWare® Internet
Services.



Copy
System administrator credentials are required to set up this feature before you can use it. For details,
refer to the System Administrator Guide at www.xerox.com/office/B1022_B1025docs.
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MMaakkiinngg aa CCooppyy
This procedure outlines the steps to copy a document using the document feeder or document glass.

Note: For information about ID card copying, refer to Copying an ID Card.

1. Load your original documents in the document feeder or on the document glass.

If the Copy feature is grayed-out, contact your system administrator to enable the feature. For
details, refer to the System Administrator Guide at www.xerox.com/office/B1022_B1025docs.
• For single pages, or paper that cannot be fed using the document feeder, use the document

glass. Place the first page of the document face down, in the top-left corner of the document
glass.

• For multiple or single pages, use the document feeder. Remove any staples and paper clips
from the pages, then place the pages face up in the document feeder.

2. At the printer control panel, press the Services Home button.
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3. Touch Copy.

4. To enter the number of copies, on the control panel touch screen, use the alphanumeric keys.

5. Touch the Right Arrow icon.

6. Change the copy settings, as needed. Refer to Adjusting Copying Options.

7. Press the green Start button.

• To pause or cancel a copy job, at the printer control panel, press the red Cancel button.

• To interrupt a copy job, at the printer control panel, press the Interrupt button.

AAddjjuussttiinngg CCooppyyiinngg OOppttiioonnss

SSeelleeccttiinngg 11--SSiiddeedd oorr 22--SSiiddeedd CCooppyyiinngg
The printer provides these copying options: 1-Sided, 2-Sided, or 2-Sided, Rotate Side 2. The 2-Sided
and 2-Sided, Rotate Side 2 copying options initiate the copying of both sides of a document.
To select 2-sided copying:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch 2-Sided Copying.

5. Select an option.
• 1 to 1 Sided: This option creates a 1-sided copy from a 1-sided original document.
• 1 to 2 Sided: This option creates a 2-sided copy from a 1-sided original document.
• 2 to 2 Sided: This option creates a 2-sided copy from a 2-sided original document.
• 2 to 1 Sided: This option creates a 1-sided copy from a 2-sided original document.

6. Select one of the options, as applicable.
• Original Rotation: From a 2-sided original document, this option creates a document with a

rotated second side.
• Output Rotation: To achieve the required output, this option creates 2-sided output with a

rotated second side.

Note: The rotation result varies, depending on the rotation option that you select. For
rotation results, refer to Rotation Option Results.

7. Touch OK.

Rotation Option Results
The blue dots in the images represent the scanner start point or edge.

• The A image represents page 1.

• The B image represents page 2.

The rotation result applies to these rotation options.

• 1 to 2–Sided rotation, if you selected the Output Rotation option

• 2 to 1–Sided rotation, if you selected the Original Rotation option
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• 2 to 2–Sided, or Landscape to Landscape rotation, if you selected the Original or Output Rotation
option

This rotation result applies to these rotation options.

• 2 to 1–Sided output if you used the Default setting, and did not select a rotation option.

• 2 to 2–Sided, or Portrait to Landscape rotation, if you selected the Output Rotation option.

This rotation result applies to 2–Sided to 2–Sided Default, or Portrait to Portrait output, if you did not
select either the Original or Output Rotation rotation option.

This rotation result applies to these rotation options.

• 2–Sided to 2–Sided, or Landscape to Portrait rotation, if you selected the Original Rotation option.

• 1 to 2–Sided Default output, if you did not select either the Original or Output Rotation option.
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CChhaannggiinngg tthhee CCoollllaattiioonn SSeettttiinngg
If you place the original documents on the document glass, you can change the collation setting for a
multiple-paged copy job.

Note: You can change the collation setting in the print driver window or at the printer control
panel.

To select a collation option:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch the Collation option.

5. Select an option:
• Collated: This option activates collation for original documents that you place on the

document glass only.
• Uncollated: This option deactivates collation for original documents that you place on the

document glass only.

6. Touch OK.

SSeelleeccttiinngg aa PPaappeerr TTrraayy
To select a paper tray:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch Paper Supply.

5. Touch one of the options.
• Auto Paper Select: This option automatically selects the paper tray best suited for your

image.
• Tray that contains the appropriate paper.

6. Touch OK.

RReedduucciinngg oorr EEnnllaarrggiinngg aann IImmaaggee
The printer can reduce or enlarge an image in the range between 25% and 400% of the original
image.
To reduce or enlarge an image:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch Reduce/Enlarge.

5. Select an option:
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• To reduce or enlarge the percentage incrementally, touch the Arrow icons.
• To reduce or enlarge the percentage using the alphanumeric keypad, touch one of the preset

values.

Note: To set the printer to size the copied image automatically, select Auto.

6. Touch OK.

SSeettttiinngg tthhee DDooccuummeenntt OOrriieennttaattiioonn
Set the orientation for the document that you want to load in the document feeder.

Note: If you place the document on the document glass, you do not have to set the
orientation of the document. In this case, the orientation depends on the direction in which
you place the document on the document glass.

To set the orientation of the original document:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, select the Original Orientation option.

5. Touch an option:
• Upright Feed Top Up: This option is the same as the portrait option.
• Sideways Feed Top Left: This option is the same as the landscape option.

6. Touch OK.

SSppeecciiffyyiinngg tthhee OOrriiggiinnaall DDooccuummeenntt TTyyppee
The printer optimizes the image quality of the copies, based on the type of images in the original
document, and how the original document was created.
To specify the original document type:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch Original Type.

5. Touch the Down Arrow icon as many times as necessary to select an option:
• Photo & Text: Use this setting for the following images:

• Documents with text and photos printed on the paper

• Photocopied documents that include text and photos

• Documents that include photos and text on photographic paper

• Photo: Use this setting for the following:

• Original photographs on photographic paper

• Photos printed on magazine paper
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• Photocopied photos

• Text: Use this setting for black-and-white or colored text.

6. Touch OK.

SSppeecciiffyyiinngg tthhee OOrriiggiinnaall DDooccuummeenntt SSiizzee
When you copy a document, you can set the size of the original document.
To specify the original document size:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch Original Size.

5. Touch an option. To enter area measurements, use the control panel keyboard.

Note: Grayed-out options are not available.
• Preset: Use this option to specify the area to copy when the copy area matches a standard

paper size.
• Custom: Use this option to specify a customized height and width of the area to copy.

6. Touch OK.

SShhiiffttiinngg aann IImmaaggee
You can change the placement of an image on a page. To shift an image, position the original
documents in the document feeder or on the document glass. If you use the document glass, position
the documents face down in the back-left corner of the document glass. Place the short edge of the
document to the left.
To shift an image:

1. Position the original documents in one of the following ways:
• For the document feeder, position original documents face up, with the short edge entering

the feeder first.
• For the document glass, position original documents face down in the back-left corner, with

the short edge to the left.

2. At the printer control panel, press the Services Home button.

3. Touch Copy.

4. On the Copy screen, touch the Right Arrow icon.

5. On the Copy Features screen, touch Image Shift.

6. If the Image Shift option is set to Off, touch the arrow, then select an option:
• Auto Center: This option centers the image within the document margins.
• Margin Shift: This option shifts the margins on the left, right, top, or bottom of the image.

7. Touch OK.
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SSeettttiinngg BBaacckkggrroouunndd SSuupppprreessssiioonn
Adjust the background suppression for documents printed on thin paper or paper with text or images
visible on the back of the paper. To reduce the sensitivity of the printer for variations in light
background colors, select Auto Suppression or adjust the background suppression settings.
To set the background suppression:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch Background Suppression.

5. Select one of the options.
• OFF: This option deactivates the Background Suppression feature.
• Auto Suppression: To improve image quality, select this option. The printer examines

automatically a sample of the document that you are scanning, and adjusts the image
quality.

• Enhance: This option improves image quality. To adjust the image quality, move the slider
between the range of 1–2. The higher the number, the more vivid the background.

• Erase: This option erases the margins from the image. To erase the margins, move the slider
between 1–4. The higher the number, the lighter the background.

6. Touch OK.

LLiigghhtteenniinngg oorr DDaarrkkeenniinngg tthhee IImmaaggee
When you copy a document, you can adjust the lightness or darkness contrast of the original image.
To lighten or darken an image:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch Lighten/Darken.

5. To adjust the intensity, move the slider control.

6. Touch OK.

SSeettttiinngg tthhee PPaaggee LLaayyoouutt
You can use Page Layout to place a defined number of pages on one or both sides of the paper.

Note: By default, Page Layout is disabled, unless you select a preset Original Size option, and
the Image Shift option is set to Off.

To set the page layout:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch Page Layout.

5. Touch an option.
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• 2 Pages: This option creates two pages on one or two sides of a document copy.
• 4 Pages: This option creates four pages on one or two sides of a document copy.
• 8 Pages: This option creates eight pages on one or two sides of a document copy.
• 16 Pages: This option creates 16 pages on one or two sides of a document copy.

6. For Paper Supply, touch the appropriate paper tray.

7. Touch OK.

SSeelleeccttiinngg BBooookk CCooppyy
For a book, magazine, or other bound document, you can copy either the left or right page onto a
single sheet of paper. You can copy left and right pages onto two sheets of paper, or as a single
image on one sheet of paper.

Note: Book Copy is disabled unless you select an Original Size option.
To select Book Copy:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch Book Copy.

5. Select an option.
• Off: This option is the default setting.
• Both Pages: This option scans both pages of an open book onto two sheets of paper.
• Left Page: This option scans the left page of an open book onto a single sheet of paper.
• Right Page: This option scans the right page of an open book onto a single sheet of paper.

6. Touch OK.

CCooppyyiinngg CCoovveerrss
You can copy the first and last pages of your copy job on speciality paper, such as colored or
heavyweight paper. The printer selects the cover paper from a different tray. You can copy covers
when you copy a book, but you cannot copy covers when you copy a booklet.
To copy covers:

1. Load the paper for the document into the appropriate paper tray.

2. Load the cover paper into a different tray.

3. At the printer control panel, press the Services Home button.

4. Touch Copy.

5. On the Copy screen, touch the Right Arrow icon.

6. For Paper Supply, touch the tray that contains the paper for the document.

Note: The printer automatically selects the cover paper from a different tray.

7. Touch OK.

8. Touch Covers.

9. Touch an option.
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10. From the Cover menu, select an option:
• Blank: This option does not copy a cover to either side of the cover paper.
• Print on Side 1 only: This option copies the cover to one side of the speciality paper.
• Print on Both Sides: This option copies the cover to both sides of the speciality paper.

11. From the Cover→Tray Selection menu, touch the tray that contains the cover paper.

12. Touch OK.

13. On the Copy screen, touch the Left Arrow icon.

14. For the number of copies, touch Quantity.

15. Press the green Start button.

CCrreeaattiinngg aa BBooookklleett
You can print copies in booklet format. The booklet feature reduces the original document images to
fit two images on each side of the printed page.

Note: In this mode, the printer scans all the original documents before it prints the copies.
To create a booklet:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. On the Copy screen, touch the Right Arrow icon.

4. On the Copy Features screen, touch Booklet Creation.

Note: If you adjusted the Reduce/Enlarge setting, a message appears confirming that
Reduce/Enlarge changed to Auto%. If you changed Paper Supply to Auto Select, a
message appears confirming that Paper Supply changed to Tray 1.

5. Touch On.

6. Touch Original Input, then select the option that matches your original documents:
• 1-Sided Original: This option scans only one side of the original image, and produces 1-sided

output files.
• 2-Sided Original: This option scans both sides of the original image.

7. Select a Paper Supply option. This is the tray that contains the appropriate paper.

8. Touch OK.
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Scan To
System administrator credentials are required to set up this feature before you can use it. For details,
refer to the System Administrator Guide at www.xerox.com/office/B1022_B1025docs.

SSeennddiinngg aa SSccaannnneedd IImmaaggee ttoo aa DDeessttiinnaattiioonn
Scanning to a PC allows you to scan to a folder on the server or to a shared folder on a personal
computer. This option also allows you to scan to an email address or an IP address, or with an Optical
Character Recognition (OCR) option.

Note: The Scan for OCR option allows you to search for or edit your scanned document in a
software program.

Before you scan to a PC, configure the destination folders on the server, or share the folder on a
personal computer. A destination does not appear on the touch screen unless already entered in
Xerox® CentreWare® Internet Services, in the Scan To Destination file. If there are no destinations for
Scan To Destination, the Scan To PC icon appears grayed-out on the touch screen.
To scan and send an image to a PC:

1. Load your original documents on the document feeder or the document glass.
• For single pages, or paper that cannot be fed using the document feeder, use the document

glass. Place the first page of the document face down, in the top-left corner of the document
glass.

Note: For details, refer to Using the Document Glass and Document Glass Guidelines.

.
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• For multiple or single pages, use the document feeder. Remove any staples and paper clips
from the pages, then place the pages face up in the document feeder.

Note: For details, refer to Document Feeder and Document Feeder Guidelines.

2. At the printer control panel, press the Clear All button, then press the Scan To button.

If the Scan To feature is grayed-out, contact your system administrator to enable the feature. For
details, refer to the System Administrator Guide at www.xerox.com/office/B1022_B1025docs.

3. Touch Scan To PC.

The Scan to PC screen appears.

4. Select an option and provide the required information.
• Scan for Print to: This option scans your image to an IP address.
• Scan for Email to: This option scans your image to a destination folder.
• Scan for OCR: This option converts printed characters into digital text.

5. To select a destination, touch the destination name.

6. Press the green Start button.

Note: Change scan settings as needed. For details, refer to Adjusting Scanning Options.

SSccaannnniinngg ttoo aann EEmmaaiill AAddddrreessss
Note:When you use this feature, the scanned images are sent as email attachments.

Before you scan to email, configure the email SMTP and From field properties. At least one email
address is required in the address book. If email properties are not configured properly, the email icon
appears grayed-out on the touch screen.
To scan to an email address:

1. Load your original documents in the document feeder or on the document glass.
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• For single pages, or paper that cannot be fed using the document feeder, use the document
glass. Place the first page of the document face down, in the top-left corner of the document
glass.

Note: For details, refer to Using the Document Glass and Document Glass Guidelines.

.
• For multiple or single pages, use the document feeder. Remove any staples and paper clips

from the pages, then place the pages face up in the document feeder.

Note: For details, refer to Document Feeder and Document Feeder Guidelines.

2. To clear previous settings, press the Clear All button.

3. Press the Services Home button.

4. On the printer control panel, touch Email.

If the Scanning to an Email Address feature is grayed-out, contact your system administrator to
enable the feature. For details, refer to the System Administrator Guide at www.xerox.com/office/
B1022_B1025docs.
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5. Enter the Recipient information.
• To type the email address into the To field, select Enter Recipient, then use the touch screen

keypad. Touch OK.
• To select a contact or group from the Address Book, touch the Device Address Book icon.

From the list, select a recipient.
• If you created Favorites, to select a Favorite, touch Favorites. From the list, select an Email

Favorite.
For details about using the Address Book, and managing and creating Favorites, refer to
Address Book.

6. Touch the Right Arrow icon.

7. Adjust the email features as needed:
• To save the scanned document with a specific file name, touch Attachment, then use the

touch screen keypad and enter a new name. Touch OK.
• To save the scanned document with a specific file format, touch the attachment file format,

then select the required format.
• To change the subject line, touch Subject, then use the keypad and enter a new subject line.

Touch OK.
• To change the email body message, touchMessage, enter a new message, then touch OK.
• If necessary, set the From and Reply To addresses.

8. Touch the Back Arrow icon.

9. To start the scan, press the Start button.

10. If you are scanning from the document glass, when prompted, to finish scanning, touch Done. To
scan another page, touch Scan.

Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

11. To return to the Home screen, press the Home button.

SSccaannnniinngg ttoo aa SShhaarreedd FFoollddeerr oonn aa NNeettwwoorrkk CCoommppuutteerr
Before you can scan to a shared folder, share the folder. In Xerox® CentreWare® Internet Services,
add the folder as an Address Book entry.

SShhaarriinngg aa FFoollddeerr oonn aa WWiinnddoowwss CCoommppuutteerr
Before you begin:

• Verify that your computer security software allows for file sharing.

• Verify that File and Printer Sharing For Microsoft Networks is enabled for each of your
connections.

Note: For assistance, contact your system administrator.
To activate sharing:

1. Open Windows Explorer.

2. Right-click the folder that you want to share, then select Properties.

3. Click the Sharing tab, then click Advanced Sharing.

4. At the prompt, Do you want to allow this app to make changes to your device?, click Yes.
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5. Select Share this folder.

6. Click Permissions.

7. Select the Everyone group, then verify that all permissions are enabled.

8. Click OK.

9. Click OK again.

10. Click Close.
Note the Share name for later use.

SShhaarriinngg aa FFoollddeerr UUssiinngg MMaacciinnttoosshh OOSS XX VVeerrssiioonn 1100..77 aanndd LLaatteerr
1. From the Apple menu, select System Preferences.

2. From the View menu, select Sharing.

3. From the Service list, select File Sharing.

4. For Shared Folders, click the Plus icon (+).

A folder list appears.

5. Select the folder that you want to share on the network, then click Add.

6. To modify access rights for your folder, select it. The groups activate.

7. From the Users list, click Everyone, then use the arrows to select Read & Write.

8. Click Options.

9. Share the folder:
• To share the folder with Windows computers, select Share files and folders using SMB.
• To share the folder with specific users, for each user name, select On.

10. Click Done.

11. Close the System Preferences window.

Note:When you open a shared folder, a Shared Folder banner appears in the Finder for the
folder and subfolders.

SSccaannnniinngg ttoo aa FFoollddeerr oonn aa NNeettwwoorrkk CCoommppuutteerr
1. Load your original documents.
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• For single pages, or paper that cannot be fed using the document feeder, use the document
glass. Place the first page of the document face down, in the top-left corner of the document
glass.

Note: For details, refer to Using the Document Glass and Document Glass Guidelines.

.
• For multiple or single pages, you can use the document feeder. Remove any staples and paper

clips from the pages, then place the pages face up in the document feeder.

Note: For details, refer to Document Feeder and Document Feeder Guidelines.

2. At the printer control panel, press the Clear All button, then press the Services Home button.

3. Touch Scan to.

If the Scanning to a Folder on a Network Computer feature is grayed-out, contact your system
administrator to enable the feature. For details, refer to the System Administrator Guide at www.
xerox.com/office/B1022_B1025docs.

4. Touch the Right Arrow icon repeatedly until the Scan To Features screen appears.

Xerox® B1025 Multifunction Printer
User Guide

57

Using the Services

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=B1022_B1025&PgName=userdocpdfs&FileName=user_guide&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=B1022_B1025&PgName=userdocpdfs&FileName=user_guide&Language=English


5. Touch OK.

6. For Scan to, touch OK.

7. For Computer (Network), touch OK.

8. To select the shared folder on your computer, touch the Arrow icons, then touch OK.

9. If you want to change any other scan settings, to select a setting, use the Arrow icons, then make
your changes. For details, refer to Adjusting Scanning Options.

10. To begin the scan, press the green Start button.

IInniittiiaattiinngg SSccaannnniinngg ffrroomm aa CCoommppuutteerr

SSccaannnniinngg ffrroomm aa PPrriinntteerr IIccoonn oonn YYoouurr CCoommppuutteerr
After you set up a printer icon on your computer, you can scan images. On your computer, click the
Printer icon.

1. At the printer, load the original document on the document glass, or in the document feeder.

2. On your computer desktop, find and right-click the appropriate Printer icon.

3. Click Start Scan.

The New Scan window appears.

Note: For convenience, you can create a shortcut on your computer desktop to the printer.
For details, refer to Creating a Shortcut on Your Windows Desktop to the Printer.

4. Select or adjust the attributes, as needed:

Note: The list of attributes varies depending on the available OCR package.

5. To scan the image, click Scan.

CCrreeaattiinngg aa SShhoorrttccuutt oonn YYoouurr WWiinnddoowwss DDeesskkttoopp ttoo tthhee PPrriinntteerr
You can create a shortcut to the printer on your Windows desktop. The shortcut gives you convenient
access to the printer for your scanned images.

1. On your desktop, search for the Control Panel.

2. Click Devices and Printers.

3. Find and right-click the image of the appropriate printer.

4. To create a shortcut on your computer desktop to the printer, click Yes.

SSccaannnniinngg ttoo aa UUSSBB FFllaasshh DDrriivvee
You can scan a document and store the scanned file on a USB Flash drive. The supported file types
are .jpg, .pdf, and .tiff.

1. At the printer, load the original document on the document glass, or in the document feeder.

2. Insert a USB Flash drive into the USB port on the front of your Xerox printer.

The control panel touch screen displays the USB Device Detected screen.
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3. If the USB Device Detected screen does not appear automatically on the control panel, touch
Scan to USB.

4. Change scan settings, as needed. For details, refer to Adjusting Scanning Options.

5. To begin the scan, press the green Start button.

Note: Do not remove the USB Flash drive until prompted. If you remove the flash drive
before the transfer is complete, you can damage the file.

AAddjjuussttiinngg SSccaannnniinngg OOppttiioonnss

SSeelleeccttiinngg 11 oorr 22--SSiiddeedd SSccaannnniinngg
This printer provides the scanning options 1-Sided, 2-Sided, or 2-Sided, Rotate Side 2. Either of the 2-
Sided scanning options initiates the scanning of both sides of the document.
To select 2-sided scanning:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Scan To.

3. Touch the Right Arrow icon repeatedly until the Scan To Features screen appears.

4. Touch 2-Sided Scanning.

5. Select an option.

6. Touch OK.

SSeettttiinngg tthhee OOuuttppuutt CCoolloorr
If the original image contains color, you can scan the image in color, grayscale, or black and white.
Selecting black and white significantly reduces the file size of the scanned images.
To set the output color:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Scan To.

3. Touch the Right Arrow icon until the Scan To Features screen appears.

4. Touch Output Color.

5. Select an output color.
• Color: This option scans the image or text in color.
• Grayscale: This option scans the image in shades of gray. Use this option to scan printed

images.
• Black/White: This option scans the image in black and white. Use this setting for black text on

a white background. This option sometimes is referred to as monochrome.

6. Touch OK.

Xerox® B1025 Multifunction Printer
User Guide

59

Using the Services



SSeettttiinngg tthhee FFiillee FFoorrmmaatt
When you scan a document to send to a network, you can set various features.
To set the file format:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Scan To.

3. Touch the Right Arrow icon repeatedly until the Scan To Features screen appears.

4. Touch File.

5. From the menu, select a file type.
• .pdf: This option scans your image as a PDF file type.
• .tif: This option scans your image as a TIF file type.
• .jpg: This option scans your image as a JPG file type.
• custom: This option allows you to select a multi-page TIF file, or a file per page TIF file.

Note: For the .jpg file type, you cannot select black and white for the color setting.

6. To type the file name, use the control panel keypad.

7. Touch OK.

IIff FFiillee EExxiissttss AAllrreeaaddyy
When you scan to a file that exists on your computer, various features are available.
To select a feature:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Scan To.

3. Touch the Right Arrow icon repeatedly until the Scan To Features screen appears.

4. Touch If File Already Exists.

5. Select the appropriate option from the menu.
• Append a Number to Name: This option adds a number to the end of the filename. Example:

xerox.001.pdf.
• Append Date & Time to Name: This option adds the date and time to the end of the

filename (YYYYMMDDhhmmss). Example: xerox20180222073818.pdf.
• Add to pdf Folder: This option adds the PDF to the folder that you created on your computer.
• Overwrite Existing File: If file names are identical, this option overwrites an existing file with

file that you are saving.

6. Touch OK.
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SSeettttiinngg tthhee DDooccuummeenntt OOrriieennttaattiioonn
Set the orientation of the document that you are loading in the document feeder.

Note: If you are placing the document on the document glass, you do not have to set the
orientation of the document. Orientation depends on the direction in which you load the
document.

To set the orientation of the original document:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Scan To.

3. Touch the Right Arrow icon repeatedly until the Scan To Features screen appears.

4. Scroll, then touch Original Orientation.

5. Touch either Upright Feed Top Up or Sideways Feed Top Left.

6. Touch OK.

LLiigghhtteenniinngg oorr DDaarrkkeenniinngg tthhee IImmaaggee
To lighten or darken an image:

1. At the printer control panel, press the Clear All button, then press the Services Homebutton.

2. Touch Scan To.

3. Touch the Right Arrow button repeatedly until the Scan To Features screen appears.

4. Touch Lighten/Darken.

5. To adjust the intensity, move the slider control.

6. Touch OK.

SSeettttiinngg BBaacckkggrroouunndd SSuupppprreessssiioonn
Adjust the background suppression for documents printed on thin paper or paper with text or images
visible on the back of the paper. Select Auto Suppression or adjust the background suppression
settings to reduce the sensitivity of the printer for variations in light background colors.
To set the background suppression:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Scan To.

3. At the top of the Scan To screen, touch the Right Arrow icon repeatedly until the Scan To
Features screen appears.

4. Touch Background Suppression.

5. Select one of the options.
• OFF: This option indicates that the Background Suppression feature is not activated.
• Auto Suppression: To improve image quality, select this option. The printer automatically

examines a sample of the document that you are scanning, and adjusts the image quality.
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• Enhance: This option improves image quality. To adjust the image quality, move the slider up
and down between the range of 1–2. The higher the number, the more vivid the background.

• Erase: This option erases the margins from the image. To erase the margins, move the slider
between 1–4. The higher the number, the lighter the background.

6. Touch OK.

SSeettttiinngg tthhee SSccaann RReessoolluuttiioonn
Set the resolution options based on the type of original document that you want to scan, and how
you plan to use the scanned image. Scan resolution affects both the size and image quality of the
scanned image file. Higher scan resolution produces better image quality and a larger file size.

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Scan To.

3. Touch the Right Arrow button repeatedly until the Scan To Features screen appears.

4. Scroll, then touch Resolution.

5. Select a DPI option:

Note: DPI indicates the scan resolution options in dots-per-inch.
• 72
• 100
• 200
• 300
• 400
• 600

Note: For details, refer to Scan Resolution Options.

6. Touch OK.

Scan Resolution Options

DPI (Dots per
Inch) Image Quality File Size Purpose

72 Acceptable Smallest This DPI setting is for onscreen viewing
only. If you print the image, it can
appear grainy.

100 Good Small This DPI setting is for onscreen viewing
only. If you print the image, it can
appear grainy.

200 Good Moderate Best suited for standard office
documents and photographs.

300 High Large Offers better image quality for standard
office documents and photographs.
Recommended for automated
processing and OCR (Optical Character
Recognition).
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DPI (Dots per
Inch) Image Quality File Size Purpose

400 Higher Very Large Used for original documents that have
thin lines, small font sizes, or for image
enlargement.

600 Highest
Extremely Large
Files scanned at 600
DPI can take longer to
transmit over a
network.

Intended for commercial-quality
printing.

SSppeecciiffyyiinngg tthhee OOrriiggiinnaall DDooccuummeenntt SSiizzee
When you scan a document to send to a network, you can set various features.
To specify the original document size:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Scan To.

3. Touch the Right Arrow icon repeatedly until the Scan To Features screen appears.

4. Scroll, then touch Original Size.

5. To select an option, touch theDown Arrow icon.
• Preset: This option provides a list of document sizes.
• Custom: This option provides a way for you to enter a custom document size or area to scan.

6. Touch OK.

SSppeecciiffyyiinngg tthhee OOrriiggiinnaall DDooccuummeenntt TTyyppee
The printer optimizes the image quality of the copies, based on the type of images in the original
document, and how the original was created.
To specify the original document type:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Scan To.

3. Touch the Right Arrow icon repeatedly until the Scan To Features screen appears.

4. Scroll, then touch Original Type.

5. Touch the Down Arrow icon as many times as necessary to select an option:
• Photo & Text: Use this setting for the following:

• Documents with text and photos printed on the paper

• Photocopied documents that include text and photos

• Documents that include photos and text on photographic paper

• Photo: Use this setting for the following:

• Original photographs on photographic paper

• Photos printed on magazine paper
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• Photocopied photos

• Text: Use this setting for black and white or colored text.

6. After you select the appropriate document type, touch OK.
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Email
You can use the Email function to scan images and attach them to emails. You can specify the file
name and format of the attachment, and include a subject heading and message for the email.
You can adjust settings for individual Email jobs, and save settings as Presets for future jobs. You can
customize the features list.

SSccaannnniinngg ttoo aann EEmmaaiill AAddddrreessss
Note:When you use this feature, the scanned images are sent as email attachments.

Before you scan to email, configure the email SMTP and From field properties. At least one email
address is required in the address book. If email properties are not configured properly, the email icon
appears grayed-out on the touch screen.
To scan to an email address:

1. Load your original documents in the document feeder or on the document glass.
• For single pages, or paper that cannot be fed using the document feeder, use the document

glass. Place the first page of the document face down, in the top-left corner of the document
glass.

Note: For details, refer to Using the Document Glass and Document Glass Guidelines.

.
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• For multiple or single pages, use the document feeder. Remove any staples and paper clips
from the pages, then place the pages face up in the document feeder.

Note: For details, refer to Document Feeder and Document Feeder Guidelines.

2. To clear previous settings, press the Clear All button.

3. Press the Services Home button.

4. On the printer control panel, touch Email.

If the Scanning to an Email Address feature is grayed-out, contact your system administrator to
enable the feature. For details, refer to the System Administrator Guide at www.xerox.com/office/
B1022_B1025docs.

5. Enter the Recipient information.
• To type the email address into the To field, select Enter Recipient, then use the touch screen

keypad. Touch OK.
• To select a contact or group from the Address Book, touch the Device Address Book icon.

From the list, select a recipient.
• If you created Favorites, to select a Favorite, touch Favorites. From the list, select an Email

Favorite.
For details about using the Address Book, and managing and creating Favorites, refer to
Address Book.

6. Touch the Right Arrow icon.

7. Adjust the email features as needed:
• To save the scanned document with a specific file name, touch Attachment, then use the

touch screen keypad and enter a new name. Touch OK.
• To save the scanned document with a specific file format, touch the attachment file format,

then select the required format.
• To change the subject line, touch Subject, then use the keypad and enter a new subject line.

Touch OK.
• To change the email body message, touchMessage, enter a new message, then touch OK.
• If necessary, set the From and Reply To addresses.

8. Touch the Back Arrow icon.

9. To start the scan, press the Start button.
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10. If you are scanning from the document glass, when prompted, to finish scanning, touch Done. To
scan another page, touch Scan.

Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

11. To return to the Home screen, press the Home button.
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Fax
If the Fax feature is grayed-out, contact your system administrator to enable the feature. For details,
refer to the System Administrator Guide at www.xerox.com/office/B1022_B1025docs.

SSeennddiinngg aa FFaaxx
1. Load your original documents.

• For single pages, or paper that cannot be fed using the document feeder, use the document
glass. Place the first page of the document face down, in the top-left corner of the document
glass.

Note: For details about using the document glass and associated guidelines, refer to
Using the Document Glass and Document Glass Guidelines.
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• For multiple or single pages, use the document feeder. Remove any staples and paper clips
from the pages, then place the pages face up in the document feeder.

Note: For details about using the document feeder and associated guidelines, refer to
Document Feeder and Document Feeder Guidelines.

2. At the printer control panel, press the Clear All button, then press the Services Home button.

3. Touch Fax.

If the Fax feature is grayed-out, contact your system administrator to enable the feature. For
details, refer to the System Administrator Guide at www.xerox.com/office/B1022_B1025docs.

4. To enter a Fax address, use one or more of the available options.
• Enter Recipient: This option allows you to enter a fax number manually.
• Device Address Book: This option allows you to access the printer address book.
• Manual Dial Mode: This option allows you to insert characters, such as Dial Pause, in a fax

number.

5. Adjust other fax options, as needed.
For details, refer to Adjusting Faxing Options.

6. Press the green Start button.

After the printer scans all pages, the printer transmits the document.

AAddjjuussttiinngg FFaaxxiinngg OOppttiioonnss

SSeelleeccttiinngg 11--SSiiddeedd oorr 22--SSiiddeedd SSccaannnniinngg
The printer provides these faxing options: 1-Sided, 2-Sided, or 2-Sided, Rotate Side 2. Either of the 2-
Sided faxing options initiates the process of faxing both sides of the document.

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax.

The Fax Features screen appears.

3. Touch the Right Arrow icon twice.

Xerox® B1025 Multifunction Printer
User Guide

69

Using the Services

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=B1022_B1025&PgName=userdocpdfs&FileName=user_guide&Language=English


4. To change the setting, touch 2-Sided Scanning. The current setting is indicated in smaller type
under the image of the icon.

5. Select the 1-Sided or 2-Sided Scanning option.

6. Touch OK.

SSeettttiinngg tthhee OOrriieennttaattiioonn ooff tthhee OOrriiggiinnaall DDooccuummeenntt
Set the orientation of the document that you are loading in the document feeder.

Note: If you are placing the document on the document glass, you do not have to set the
orientation of the document. In this case, the orientation depends on the direction in which
you load the document.

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax.

3. Touch the Right Arrow icon twice.

The Fax Features screen appears.

4. Touch Original Orientation.

5. Touch an option:
• Upright Feed Top Up
• Sideways Feed Top Left

6. Touch OK.

LLiigghhtteenniinngg oorr DDaarrkkeenniinngg tthhee IImmaaggee
1. At the printer control panel, press the Clear All button, then press Services Home button.

2. Touch Fax.

3. At the top of the Fax screen, touch the Right Arrow icon twice.

The Fax Features screen appears.

4. Touch Lighten/Darken.

5. To adjust the intensity, move the slider control.

6. Touch OK.

SSeettttiinngg BBaacckkggrroouunndd SSuupppprreessssiioonn
Adjust the background suppression setting for these conditions:

• For documents printed on thin paper or paper with text or images visible on the back of the paper.

• To reduce the sensitivity of the printer to variations in light background colors.

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax.

3. At the top of the Fax screen, touch the Right Arrow icon twice.

The Fax Features screen appears.
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4. Touch Background Suppression.

5. Select one of the options:
• OFF: This option indicates that the Background Suppression feature is not activated.
• Auto Suppression: To improve image quality, select this option. The printer automatically

examines a sample of the document that you are scanning, and adjusts the image quality.
• Erase: To erase the margins from the image, move the slider between 1 - 4. The higher the

number, the lighter the background.

6. Touch OK.

SSeennddiinngg HHeeaaddeerr TTeexxtt
If the Sending Header Text feature is grayed-out, contact your system administrator. For details, refer
to the System Administrator Guide at www.xerox.com/office/B1022_B1025docs.
To include the fax header text in a fax:

1. At the printer control panel, press the Clear All button, then press Services Home button.

2. Touch Fax.

3. At the top of the Fax screen, touch the Right Arrow icon twice.

The Fax Features screen appears.

4. Touch Send Header Text.

5. Touch Off or On.

6. Touch OK.

SSeennddiinngg aa DDeellaayyeedd FFaaxx
You can scan and save a fax on the printer, then send the fax later. You can set a delay time of 15
minutes to 24 hours. If you do not set a delay time, the printer sends the job immediately.

Note: If this feature is not set up, contact the system administrator for assistance.

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax.

3. At the top of the screen, touch the Right Arrow icon twice.

4. Touch Delay Send.

5. To enable the delayed fax feature, from the menu, select ON.

6. Touch the Hour field. To set a number, touch the Arrow icons.

7. Touch theMinute field. To set a number, touch the Arrow icons.

8. If your printer is set to display the 12-hour clock, touch AM or PM.

9. Touch OK.
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SSeettttiinngg tthhee FFaaxx RReessoolluuttiioonn
Set the fax resolution options based on the type of original document that you want to fax. Fax
resolution affects both the size and image quality of the faxed document file. Higher fax resolution
produces better image quality and a larger file size.

1. At the printer control panel, press Clear All, then press the Services Home button.

2. Touch Fax.

3. Touch the Right Arrow button twice.

The Fax Features screen appears.

4. Touch Resolution.

5. Select an option:
• Image Quality Name and DPI
• Image Quality Description
• File Size
• Purpose

Note: For more information, refer to Fax Resolution Options.

6. Touch OK.

Fax Resolution Options

Image Quality
Name and DPI

Image Quality
Description File Size Purpose

Standard: 200 x
100 dots per inch

Standard Moderate Use this setting for standard office
documents and photographs.

Fine: 200 dots per
inch

Good Moderate Use this setting for standard office
documents and photographs.

Super Fine: 600
dots per inch

Highest Extremely Large

Important: These
files are not ideal for
transmitting over the
network.

Use this setting for commercial-quality
printing.

SSppeecciiffyyiinngg tthhee OOrriiggiinnaall DDooccuummeenntt SSiizzee
To ensure that the printer scans the correct area of your document, specify the original document
size.

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax.

3. Touch the Right Arrow icon twice.

The Fax Features screen appears.

4. Touch Original Size or select one of the preset paper sizes.

5. Touch OK.

72 Xerox® B1025 Multifunction Printer
User Guide

Using the Services



SSppeecciiffyyiinngg tthhee OOrriiggiinnaall DDooccuummeenntt TTyyppee
To indicate the type of original document that you want to fax, use the Original Document Type
setting.

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax.

3. Touch the Right Arrow icon twice.

The Fax Features screen appears.

4. Touch the Original Type icon.

5. Select an option:
• Photo & Text: Use this option when the fax contains both a photo and text.
• Photo: Use this option when the fax contains only photos.
• Text: Use this option when the fax contains only text.

6. Touch OK.

UUssiinngg FFaaxx MMaaiillbbooxxeess

SSttoorriinngg aa FFaaxx iinn aa LLooccaall MMaaiillbbooxx
Note: To enable this feature, contact your system administrator. The system administrator uses
the Store to Mailbox feature to create a mailbox, and enable and configure the options. For
details, refer to the System Administrator Guide: www.xerox.com/office/B1022_B1025docs

To store a fax in a local mailbox:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax→Mailboxes→Store To Mailbox.

3. Touch Local Mailbox→Enter Mailboxes

4. To enter a mailbox number and passcode, use the control panel touch screen.

5. Touch OK.

SSttoorriinngg aa FFaaxx ttoo aa RReemmoottee MMaaiillbbooxx
1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax→Mailboxes.

3. Touch Store To Mailbox→Remote Mailbox→Enter Mailboxes.

4. To enter a remote fax number or remote mailbox number, use the control panel touch screen.

5. Touch OK.

PPrriinnttiinngg LLooccaall oorr RReemmoottee MMaaiillbbooxx DDooccuummeennttss
Use this feature for documents stored in a mailbox. To print local mailbox documents:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax→Mailboxes.

Xerox® B1025 Multifunction Printer
User Guide

73

Using the Services

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=B1022_B1025&PgName=userdocpdfs&FileName=user_guide&Language=English


3. Touch Print From Mailbox.

4. From the menu, touch Local Mailbox or Remote Mailbox.

5. To enter a mailbox number and pass code, use the touch screen keyboard.

6. Touch Print.

PPoolllliinngg

PPoolllliinngg aa RReemmoottee FFaaxx
To retrieve documents stored on another fax machine, use remote polling.
To poll a remote fax:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax→Polling.

3. Touch Retrieve/Print Remote Files.

4. To enter the fax number, use the control panel touch screen.

5. Touch OK.

SSttoorriinngg aa FFaaxx ffoorr LLooccaall oorr RReemmoottee PPoolllliinngg
To prepare fax documents stored on one printer for remote polling by other printers, enable Secure or
Non-Secure Local Polling. When Secure Local Polling is activated, you can create a list of fax numbers
that allow the printer to access stored faxes on the printer.
To store a fax:

1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax→Polling.

3. Touch Store Locally for Remote Polling.

4. You can select the name of a fax recipient that appears on the screen, or add a recipient. Select
an option:
• Select a Recipient
• Add a Recipient

5. At the top of screen, touch the Right Arrow icon.

6. To adjust fax options, touch an option on the Fax Features screen.
For details, refer to Adjusting Faxing Options.

PPrriinnttiinngg oorr DDeelleettiinngg AAllll SSttoorreedd FFaaxxeess
1. At the printer control panel, press the Clear All button, then press the Services Home button.

2. Touch Fax→Polling.

3. Touch Local File Management, then select Print All Files or Delete All Files.
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ID Card Copy
You can use the ID Card Copy service to copy both sides of an ID card or small document onto one
side of paper. To copy the card, place each side on the document glass. The printer stores both sides
of the document, then prints them side by side on the paper.

CCooppyyiinngg aann IIDD CCaarrdd
To copy an ID card:

1. Press the Services Home button, then scroll down and touch ID Card Copy.

2. To select the number of copies, use the control panel the keypad.

3. Touch the Right arrow.

4. To change ID Card copy options, touch each tab, then make the needed changes. You can change
the paper supply, lighten or darken an image, or use auto suppression.

5. Lift the document cover.

6. Place the ID card, or a document smaller than half the selected paper supply size, in the upper
left corner of the document glass.

7. Press the Start button.
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The printer copies and stores the first side of the ID card. You are prompted to turn over the ID
card, then press the Start button.

8. To copy the second side of the ID card, repeat the previous steps.

The printer copies the second side of the ID card.

9. Lift the document cover, then remove the ID card or document.
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USB
Use the USB service to scan and save images to a USB Flash drive, or to print from a USB Flash drive.
Scanned images are saved in .jpg , .pdf and .tif file formats. Print jobs already stored on a USB drive
must be in a print-ready format, such as PDF, TIFF, or JPEG.

SSccaannnniinngg ttoo aa UUSSBB FFllaasshh DDrriivvee
You can scan a document and store the scanned file on a USB Flash drive. The supported file types
are .jpg, .pdf, and .tiff.

1. At the printer, load the original document on the document glass, or in the document feeder.

2. Insert a USB Flash drive into the USB port on the front of your Xerox printer.

The control panel touch screen displays the USB Device Detected screen.

3. If the USB Device Detected screen does not appear automatically on the control panel, touch
Scan to USB.

4. Change scan settings, as needed. For details, refer to Adjusting Scanning Options.

5. To begin the scan, press the green Start button.

Note: Do not remove the USB Flash drive until prompted. If you remove the flash drive
before the transfer is complete, you can damage the file.

PPrriinnttiinngg ffrroomm aa UUSSBB DDeevviiccee
You can print the following types of files directly from a USB device:

• .jpg

• .pdf

• .ps

• .pcl

• .prn

• .tiff

Note: If USB ports are disabled, you cannot use a USB card reader for authentication. In
addition, you cannot update the software or print from a USB device.

Before you begin, ensure that your system administrator set up and enabled the feature on your
Xerox printer. For details, refer to the System Administrator Guide at www.xerox.com/office/B1022_
B1025docs.
To print from a USB device:

1. Insert your USB device in a USB port on the printer. The Print from USB window appears.

2. To locate the printable file from the list on the printer control panel, scroll up or down.

3. If the print file is in a folder, open the folder, and then touch the folder name.

4. Touch the name of the printable file, and then touch OK.

5. To select print options, touch the Forward Arrow icon located in the upper right corner of the
window.
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6. Press the green Start button.

7. To print another file from the USB device, touch the Back Arrow icon located in the upper right
corner of the window.

8. Touch Add File.
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Saved Jobs
Saved jobs are documents sent to the printer and stored there for future use. Any saved jobs appear
on the Saved Jobs page. Use the Saved Jobs service to view, print, and delete saved jobs, and create
and manage folders in which they are stored.

PPrriinnttiinngg ffrroomm tthhee SSaavveedd JJoobbss LLiisstt
1. At the printer control panel, press the Services Home button, then touch Saved Jobs.

2. Touch the name of the saved job that you want to print.

3. Touch OK.

4. Press the green Start button.

5. To return to the list of saved jobs, after the job prints, touch Browse.
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Address Book
Use the Address Book feature to create contacts for use with the Email, Fax, and Scan services.

• You can add contacts to the Address Book using Xerox® Centreware® Internet Services.

• You can use the Address Book feature to scan documents to contacts in an address book.

AAddddiinngg aa CCoonnttaacctt ttoo aann AAddddrreessss BBooookk
To add a contact as an address book entry, use Xerox®CentreWare® Internet Services.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

2. Click Address Book.

3. Click the Add icon.

4. Provide information for the following fields:
• First Name: Type the first name that you want to appear in the Address Book.
• Last Name: Type the last name that you want to appear in the Address Book.
• Company: Type the company name to which the contact is associated.
• Display Name: Type the name of the contact as you want the name to appear on the printer

control panel. The Display Name is required.

Note: You can set up a contact name to appear as a favorite on the printer control
panel. After you enter the display name, click theMake Global Favorite Star icon.

• Email : Type the email address for the address book contact.

Note: You can set up an email address to appear as a favorite on the printer control
panel. After you enter the email address for the contact, click theMake Email Favorite
Star icon.

5. Click the Scan To Destination icon.

6. Provide information for the following fields:
• Nickname: Type the name of the scan destination. The nickname is required.
• Protocol: Select the format of the file transfer. Available protocols are FTP, SMB, HTTP,

HTTPS, and SFTP.
• Address Type: Identify the address type of your computer. Select IPv4 Address or Host

Name, then enter the required information.
• Document Path: Enter the path, and the directory or folder name where the scanned files are

stored on your computer.
• Login Name: Enter your computer user name. The Login Name is required.

Note: You can set your nickname and login name to appear on the printer control
panel. After you enter your nickname and login name, click theMake Scan Favorite
Star icon.

• Password: Enter your computer login password.
• Retype Password: Enter your login password again.

7. To save the new password, click Select to save new password.

8. Click Save.
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IImmppoorrttiinngg aa CCoonnttaacctt EEnnttrryy iinnttoo aann AAddddrreessss BBooookk
You can import a contact entry into an address book using Xerox®CentreWare® Internet Services
software.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

2. Click Address Book.

3. Click the Import From File icon.

4. Click Browse, then select the Address Book file that you want to import.

Note: You can import only .csv files.

5. For Existing Content Management, click Add new contacts to the existing Device Address Book
or Replace existing Device Address Book with the new contacts.

6. Click Upload File.

7. Verify the information in the address book fields.

8. Click Import.

EEddiittiinngg oorr DDeelleettiinngg aann AAddddrreessss BBooookk CCoonnttaacctt iinn
XXeerrooxx®® CCeennttrreeWWaarree®® IInntteerrnneett SSeerrvviicceess
To edit or delete Address Book contacts:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

2. Click Address Book, then select the contact.

3. Edit or delete the contact name or information.
• To edit the selected contact name or contact information, click Edit. Edit the information as

needed. To save the changes, click Save.
• To delete the selected contact from the Address Book, click Delete. At the prompt, click OK.
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Job Status
You can use the Job Status button to view information about current and completed jobs.

VViieewwiinngg JJoobb SSttaattuuss oonn tthhee CCoonnttrrooll PPaanneell
To view a list of active and completed jobs on the control panel:

1. At the control panel, press the Job Status button.

2. To view a list of active jobs, touch Active.

3. To view a list of completed jobs, touch Completed.

4. To view a list of secure jobs, touch Secure Jobs.

5. To print all jobs, touch the jobs, then touch Print All.

6. To delete all jobs, touch the jobs, then touch Delete All.

DDeelleettiinngg aann AAccttiivvee PPrriinntt JJoobb
You can delete an active print job from the printer control panel.

Note: The system administrator can restrict users from deleting jobs. If a system administrator
has restricted job deletion, you can view the jobs, but cannot delete them. Only the user who
sent the job, or the system administrator, can delete an active print job.

1. At the printer control panel, press the Job Status button.

2. Touch the Active Jobs tab.

3. To delete the print job, from the Active Jobs list, touch the name of the job, then touch Delete.
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Machine Status
You can use the Machine Status feature to view information about the printer:

• Machine Information

• Active Messages

• Supplies

• Billing Information

LLooccaattiinngg tthhee IIPP AAddddrreessss ooff tthhee PPrriinntteerr
You can view the IP address of your printer on the control panel or on the Configuration Report.

Note:

• You need the IP address of your printer to install print drivers for a network-connected
printer.

• Use the IP address to access and configure any printer settings in Xerox® CentreWare®
Internet Services.

1. To view the IP address of the printer on the control panel, press theMachine Status button.

2. TouchMachine Information. If your system administrator set the Display Network Settings to
show the IP address, it appears in the Machine Information list.

Note: If the IP address does not appear in the Machine Information list, to view the IP
address, print the Configuration Report, or contact your system administrator. To print a
Configuration Report, refer to Printing the Configuration Report.

VViieewwiinngg WWaarrnniinngg MMeessssaaggeess oonn tthhee CCoonnttrrooll PPaanneell
When a warning condition occurs, a message appears on the control panel to inform you of the
problem. Warning messages inform you about printer conditions, such as low supplies or open doors,
that require your attention.

VViieewwiinngg FFaauullttss aanndd AAlleerrttss MMeessssaaggeess oonn tthhee CCoonnttrrooll PPaanneell
When an error condition occurs, a message appears on the control panel to inform you of the
problem. Error messages warn you about printer conditions that prevent the printer from printing, or
degrade printing performance. If more than one error occurs, only one is displayed on the control
panel.
To view a list of the current errors on the control panel:

1. At the printer control panel, press theMachine Status button.

2. Touch the Active Messages tab.

3. Touch the Faults and Alertsmenu, then choose an option.
• Faults: This option shows the error messages that affect the printer operation, and the

corresponding fault codes.
• Alerts: This option shows alert messages about the printer status, and the corresponding alert

codes.
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VViieewwiinngg PPrriinntteerr SSuupppplliieess SSttaattuuss
You can check the status of your printer supplies at any time using Xerox® CentreWare Internet
Services or the printer control panel.

Note: To view printer supplies status using Xerox® CentreWare® Internet Services, refer to the
System Administrator Guide at www.xerox.com/office/B1022_B1025docs.

To view printer supplies status:

1. At the printer control panel, press theMachine Status button.

2. Touch the Supplies option. A listing of supplies status appears.

VViieewwiinngg BBiilllliinngg MMeetteerr IInnffoorrmmaattiioonn
Billing meter information appears on the Billing Information screen. The impression counts onscreen
are used for billing.
To view billing and usage information:

1. At the printer control panel, press theMachine Status button.

2. To view basic impression counts, touch the Billing Information option.

Note: A page is one side of a sheet of paper. A sheet that has printing on two sides counts
as two impressions.

The serial number of the printer, number of black impressions, number of total impressions, and
the Usage Counters option appear.

3. To view and update all usage counters, touch the Usage Counters option.

4. To select and view any of the counters, use the menu, then select a counter.
• Impression Counters
• Sheet Counters
• Images Sent Counters
• Fax Impression Counters
• All Usage Counters

5. To update counter data to current usage, touch the Update Counters option.
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Printing Overview
Before printing:

• Plug in your computer and printer

• Power on the printer

• Connect the printer internally, or to an active network

• Ensure that you have the correct print driver software installed on your computer.

1. Select the appropriate paper.

2. Load the paper in the appropriate tray.

3. At the printer control panel, specify the paper size and paper type.

4. In your software application, access the print settings.
• For Linux, press CTRL→P.
• For Macintosh, press CMD→P.
• For Windows, press CTRL→P.

5. Select your printer.

6. To access the print driver settings: for Windows, select Printer Properties or Preferences.
• For Linux, to launch the print manager dialog window, type sudo xeroxprtmgr. For the

queue to be modified, select Queue Preferences or Queue Properties.
• For Macintosh, select Xerox Features.
• For Windows, select Printer Properties or Preferences.

7. Select the needed options.

8. To send the job to the printer, click Print.
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Selecting Printing Options
Printing options, or print driver software options, are named differently, depending on the software
application that you are using.

• For Linux, the xeroxprtmgr command line utility is used to launch a queue manager. The use of
this command line utility allows the user to modify installed Xerox print queues.

• For Macintosh, printing options are named Xerox Features.

• For Windows applications, printing options are named Printer Properties.

Printing options include settings for 2-sided printing, page layout, and print quality. You can choose
default settings for various printing options.
For more information, refer to Setting Printing Defaults in Windows and Selecting Printing Options for
Macintosh. Printing options that you set from within the software application are temporary and are
not saved.

PPrriinntt DDrriivveerr HHeellpp
Xerox® print driver software Help is available from the Printer Properties window. To see print driver
help, in the Printer Properties window, in the bottom left corner, click Help (?). Information about
Printer Properties window tabs and options appears in the Help window.
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WWiinnddoowwss PPrriinnttiinngg OOppttiioonnss

SSeettttiinngg PPrriinnttiinngg DDeeffaauullttss iinn WWiinnddoowwss
When you print from any software application, the printer uses the print job settings specified in the
Printer Properties window. You can specify common printing options, then save the options so that
you do not have to change them every time you print.
For example, if you want to print on both sides of the paper for your jobs, in Printer Properties, specify
2-sided printing.
To select default printing options:

1. On your computer, navigate to the list of printers.
• For Windows Vista, click Start→Control Panel→Hardware and Sound→Printers.
• For Windows Server 2008 and later, click Start→Settings→Printers.
• For Windows 7, click Start→Devices and Printers.
• For Windows 8, click Start→Control Panel→Devices and Printers.
• For Windows 10, click Start→Settings→Devices→Printers & Scanners. Under Related

settings, click Devices and Printers.

2. In the list of printers, right-click the icon for your printer, then select Printing Preferences or
Manage→Printing Preferences.

3. In the Printing Preferences window, click a tab, then select the options. To save the setting, click
OK.

For more information about Windows print driver options, in the Printing Preferences window,
click Help (?).

SSeelleeccttiinngg WWiinnddoowwss PPrriinntt OOppttiioonnss ffoorr aann IInnddiivviidduuaall JJoobb
To use special printing options for a particular job, before you send a job to the printer, change the
Printer Properties. For example, if you want the highest print quality for your document, in the Printer
Properties dialog, select Printing Options→Print Quality→Enhanced.

1. With the document open in your software application, access the print settings. For most
software applications, click File→Print, or press CTRL→P.

2. Select your printer from the list, then click Printer Properties. The title of the button varies,
depending on your software application.

3. In the Printer Properties window, click a tab, then select the required options.

4. To save your selections and close the Printer Properties window, click OK.

5. To send the job to the printer, click Print.

SSaavviinngg aa SSeett ooff CCoommmmoonnllyy UUsseedd PPrriinnttiinngg OOppttiioonnss ffoorr WWiinnddoowwss
You can define and save a set of printing options that you can apply to future print jobs.
To save a set of printing options:

1. With the document open in your software application, click File→Print.

2. Select the printer, then click Printer Properties.

3. In the Printer Properties window, select the appropriate options.

4. To save the settings, click Saved Settings→Save As.

88 Xerox® B1025 Multifunction Printer
User Guide

Printing



5. Type a name for the set of printing options, then click OK.

6. To print using your saved options, from the Saved Settings list, select the saved name.

MMaacciinnttoosshh PPrriinnttiinngg OOppttiioonnss

SSeelleeccttiinngg PPrriinnttiinngg OOppttiioonnss ffoorr MMaacciinnttoosshh
To use specific printing options, before you send a job to the printer, change the print settings.

1. With the document open in your application, click File→Print.

2. Select your printer.

3. Select Xerox Features.

4. Select the options needed.

5. Click Print.

SSaavviinngg aa SSeett ooff CCoommmmoonnllyy UUsseedd PPrriinnttiinngg OOppttiioonnss ffoorr MMaacciinnttoosshh
You can define and save a set of options that you can apply to future print jobs.
To save a set of printing options:

1. With the document open in your application, click File→Print.

2. In the printer list, select your printer.

3. Select the printing options needed.

4. To save the settings, click Save Current Settings as Preset.

LLiinnuuxx PPrriinnttiinngg OOppttiioonnss

XXeerrooxx®® PPrriinntteerr MMaannaaggeerr
Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in
UNIX and Linux environments.
Xerox® Printer Manager allows you to:

• Configure and check the status of network-connected printers.

• Set up a printer on your network. After installation, you can monitor printer operation.

• Perform printer maintenance checks.

• View supplies status at any time.

• Provide a common look across many different suppliers of UNIX and Linux operating systems.
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Installing the Xerox® Printer Manager
Before you begin, to install Xerox® Printer Manager, ensure that you have root or superuser privileges.
To install the Xerox® Printer Manager:

1. Download the appropriate package for your operating system. To locate print drivers for your
printer, go to www.xerox.com/office/B1022_B1025drivers.

2. On the print driver website, navigate to your printer model.

3. For your printer model, click Drivers & Downloads.

4. From the Operating System menu, select your operating system.

5. To identify the print driver for your printer model, review the list of available print drivers. For
additional information about each driver, click Description.

6. Click the print driver for your printer model and operating system.

7. To begin the download, read the End User License Agreement, then click Accept.

The file downloads automatically to the default location for your computer file downloads.

8. To install the Xerox® Print Driver package for Linux:

a. Download the deb or rpm file.

b. To install the Print Driver package using a command-line utility, navigate to the directory
where you downloaded the file.

c. To run the installer, type the appropriate command-line utility for your operating system. For
example:

• Red Hat: rpm -U <filename>.rpm

• Debian-based Linux: dpkg -i <filename>.deb

• AIX: rpm -U <filename>.rpm

• HPUX: <filename>.depot.gz

• Solaris: pkgadd -d <filename>.pkg

Note:Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional
information about utilities included in the OS package manager, refer to the manual
included with the package. For example, man xeroxprtmgr.

LLaauunncchhiinngg tthhee XXeerrooxx®® PPrriinntteerr MMaannaaggeerr
To launch Xerox®Printer Manager from a command-line prompt:

1. Log in as root.

2. Type xeroxprtmgr.

Note: Another way to access the Xerox Printer Manager is to run the xeroxprtmgr
command as root using sudo.

3. Press Enter or Return.
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PPrriinnttiinngg ffrroomm aa LLiinnuuxx WWoorrkkssttaattiioonn
The Xerox® print driver accepts a job ticket setting file that contains preset printing features. You can
submit print requests through the command line using lp/lpr. For more information about Linux
printing, in the Xerox® print driver, click Help (?).

1. Create a print queue.
To set up a queue, refer to the System Administrator Guide at www.xerox.com/office/B1022_
B1025docs.

2. With the required document or graphic open in your application, open the Print dialog box.
For most software applications, click File→Print, or press CTRL→P.

3. Select the target print queue.

4. To access the print time dialog of the Xerox® print driver, click Print in the Linux print dialog box.

5. Close the Print dialog box.

Note: If you close the dialog box in another way, the print driver dialog box is not
accessible.

6. In the Xerox® print driver, select the available printer features.

7. Click Print.

Creating a Job Ticket Using the Xerox® Print Driver
1. From a command-line prompt, open the Xerox® print driver. Log in as root, then type

xeroxprtmgr.

Note: In addition, you can access the Printer Manager by running the xeroxprtmgr
command as root.

2. On the My Printers screen, select your printer.

3. In the top corner, click Edit Printer, then select options for the print job.

4. Click Save As, then store the job ticket in your home directory.

Personally identifiable information, such as a Secure Print passcode, is not saved in the job ticket.
You can specify the information on the command line.
To print using the job ticket, type the command xeroxprint -d{Target_Queue} - oJT=
<path_to_ticket> <file_name>.

The following commands are examples of how to print using a job ticket:
xeroxprint -d{Target_Queue} -oJT={Absolute_Path_To_Job_Ticket} {Path_To_
Print_File}
xeroxprint -dMyQueue -oJT=/tmp/DuplexedLetterhead /home/user/
PrintReadyFile
xeroxprint -dMyQueue -oJT=/tmp/Secure -oSecurePasscode=1234 /home/user/
PrintReadyFile

MMoobbiillee PPrriinnttiinngg OOppttiioonnss
You can print from iOS and Android mobile devices to the Xerox printer. For more information, refer to
Printing from a Device Using Mopria or Google Cloud Print.
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PPrriinnttiinngg wwiitthh WWii--FFii DDiirreecctt
You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or
smartphone, using Wi-Fi Direct.
For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

Note: Depending on which mobile device you are using, the printing procedure varies.

UUssiinngg tthhee PPrriinntt FFrroomm FFeeaattuurree
The Print From feature allows printing of documents stored on the printer, a personal computer, a
network computer, or a USB device.

PPrriinnttiinngg ffrroomm tthhee SSaavveedd JJoobbss LLiisstt
1. At the printer control panel, press the Services Home button, then touch Saved Jobs.

2. Touch the name of the saved job that you want to print.

3. Touch OK.

4. Press the green Start button.

5. To return to the list of saved jobs, after the job prints, touch Browse.

PPrriinnttiinngg ffrroomm aa UUSSBB DDeevviiccee
You can print the following types of files directly from a USB device:

• .jpg

• .pdf

• .ps

• .pcl

• .prn

• .tiff

Note: If USB ports are disabled, you cannot use a USB card reader for authentication. In
addition, you cannot update the software or print from a USB device.

Before you begin, ensure that your system administrator set up and enabled the feature on your
Xerox printer. For details, refer to the System Administrator Guide at www.xerox.com/office/B1022_
B1025docs.
To print from a USB device:

1. Insert your USB device in a USB port on the printer. The Print from USB window appears.

2. To locate the printable file from the list on the printer control panel, scroll up or down.

3. If the print file is in a folder, open the folder, and then touch the folder name.

4. Touch the name of the printable file, and then touch OK.

5. To select print options, touch the Forward Arrow icon located in the upper right corner of the
window.

6. Press the green Start button.
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7. To print another file from the USB device, touch the Back Arrow icon located in the upper right
corner of the window.

8. Touch Add File.
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Printing Features

MMaannaaggiinngg JJoobbss

MMaannaaggiinngg JJoobbss aatt tthhee CCoonnttrrooll PPaanneell
From the printer control panel Job Status window, you can view lists of active jobs or completed jobs.
You can pause, delete, print, or view job progress or job details for a selected job.

Cancelling a Print Job
1. At the printer control panel, press the Stop button.

2. Touch Cancel.

Pausing and Resuming a Print Job
There are two ways to pause and resume a print job.

1. At the printer control panel, press the Stop button or the Interrupt button.

2. To pause and resume a print job, select one of the following methods:

• Press the Stop button, then touch Resume.

• Press the Interrrupt button, and then press the Interrupt button again.

Viewing Active or Completed Print Jobs
You can view active or completed print jobs at the printer control panel.

1. At the printer control panel, press the Job Status button.

2. To see a list of specific job types, touch a tab.
• To view jobs that are in process or waiting to process, touch the Active Jobs tab.

• To view completed jobs, touch the Completed Jobs tab.

3. To view details about a job, touch the job name, and select Details.

Deleting an Active Print Job
You can delete an active print job from the printer control panel.

Note: The system administrator can restrict users from deleting jobs. If a system administrator
has restricted job deletion, you can view the jobs, but cannot delete them. Only the user who
sent the job, or the system administrator, can delete an active print job.

1. At the printer control panel, press the Job Status button.

2. Touch the Active Jobs tab.

3. To delete the print job, from the Active Jobs list, touch the name of the job, then touch Delete.

MMaannaaggiinngg JJoobbss iinn XXeerrooxx®® CCeennttrreeWWaarree®® IInntteerrnneett SSeerrvviicceess
You can use Xerox® CentreWare® Internet Services to view a list of active jobs, and delete print jobs
from the Active Jobs list. You can print, copy, move, or delete saved jobs.
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PPrriinnttiinngg SSppeecciiaall JJoobb TTyyppeess
Special job types allow you to send a print job from your computer, then print the job from the Xerox
device control panel. To select special job types from the print driver, select Printing Options→Job
Type.

PPrriinnttiinngg aa SSaavveedd JJoobb
1. In your software application, access the print settings.

• For Linux, press CTRL+P.
• For Macintosh, press CMD+P.
• For Windows, press CTRL+P.

2. Select your printer, then open the print driver.
• For Linux, click in the Print window, and the Xerox Print UI appears.
• For Macintosh, in the Print window, click Print Options, then select Xerox Features.
• For Windows, click Printer Properties. Depending on your application, the title of the button

can vary.

3. For Job Type, select Saved Job.

4. Type a job name or select a name from the list, then click OK.

5. Select any other required printing options.
• For Linux, Click Print.
• For Macintosh, click Print.
• For Windows, click OK, then click Print.

PPrriinnttiinngg aa SSeeccuurree PPrriinntt JJoobb
1. In your software application, access the print settings.

• For Linux, press CTRL>P.
• For Macintosh, press CMD+P.
• For Windows, press CTRL>P.

2. Select your printer, then open the print driver.
• For Linux, in the Print window, click Print. The Xerox Print UI appears.
• For Macintosh, in the Print window, click Print Options, then select Xerox Features.
• For Windows, click Printer Properties. Depending on your application, the title of the button

varies.

3. For Job Type, select Secure Print.

4. Type the passcode, confirm the passcode, then click OK.

5. Select any other required print options.
• For Linux, click Print.
• For Macintosh, click Print.
• For Windows, click OK, then click Print.

SSeelleeccttiinngg PPaappeerr OOppttiioonnss ffoorr PPrriinnttiinngg
The available paper options for printing are:

• Default paper size/color/type

• Other Size
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• Other Color

• Other Type

• Select By Tray

Designate the paper you want to use in one of the following ways:

• Select the Auto-Select feature. When this feature is set, the printer automatically selects which
paper to use, based on the document size, paper type, and paper color.

• Select the specific tray loaded with the paper that you want to use.

SSccaalliinngg
Scaling reduces or enlarges the original document to match the selected output paper size. To access
Scaling Options, in the Printer Properties window, select Printing Options→Paper→Other
Size→Advanced Paper Size→Scaling Options.

• No Scaling: This option does not change the size of the printed image. The image measurement
100% appears in the percentage box. If the original document size is larger than the output size,
the printer crops the image. If the original document size is smaller than the output size, extra
space appears around the image.

• Automatically Scale: This option scales the document to fit the selected Output Paper Size. The
scaling amount appears in the percentage box for the sample image.

• Manually Scale: This option scales the document by the amount entered in the percentage box
for the preview image.

PPrriinnttiinngg oonn BBootthh SSiiddeess ooff tthhee PPaappeerr

PPaappeerr TTyyppeess ffoorr AAuuttoommaattiicc 22--SSiiddeedd PPrriinnttiinngg
The printer can print a 2-sided document automatically on supported paper. Before printing a 2-sided
document, verify that the paper type and weight are supported.

PPrriinnttiinngg aa 22--SSiiddeedd DDooccuummeenntt
Options for automatic 2-sided printing are specified in the print driver. To print the document, the
print driver uses the software application settings for portrait or landscape orientation.

22--SSiiddeedd PPaaggee LLaayyoouutt OOppttiioonnss
You can specify the page layout for 2-sided printing, which determines how the printed pages turn.
These settings override the application page-orientation settings.
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Portrait Landscape

2-Sided Print 2-Sided Print, Flip on
Short Edge

2-Sided Print 2-Sided Print, Flip on
Short Edge

PPrriinnttiinngg MMiirrrroorr IImmaaggeess
If the PostScript print driver is installed, you can print pages as a mirror image in Advanced Settings.
Images mirror left to right when printed.

PPrriinnttiinngg MMuullttiippllee PPaaggeess ttoo aa SSiinnggllee SShheeeett

For a multiple-page document, you can print more than one page on
a single sheet of paper.
1 In your software application, access the print settings. For Windows,

press CTRL+P. For Macintosh, press CMD+P. For Linux, press CTRL+P.
2 From the list, select your printer, then click Printer Properties. In the

native Linux Print UI, to access the Xerox Print UI, click Print.
3 In the Document Options tab, select Page Layout.
4 Select the required number of pages per sheet, then click OK, or you can

select Booklet Layout.
5 In the Print window, click Print.

PPrriinntt QQuuaalliittyy
PostScript print driver print-quality modes:

• Standard print-quality mode: 600 x 600 dpi (dots per inch)

• Enhanced print-quality mode: 1200 x 1200 dpi

Printer Control Language (PCL) print driver print-quality modes:

• Standard print-quality mode: 600 x 600 dpi (dots per inch)

• Enhanced print-quality mode: 1200 x 1200 dpi

PPrriinnttiinngg BBooookklleettss
With 2-sided printing, you can print a document in the form of a small booklet. You can create
booklets from any paper size that is supported for 2-sided printing.
The print driver reduces each page image automatically and prints four page images for each sheet
of paper, two page images on each side. The pages are printed in the correct order so that you can
fold and staple the pages to create the booklet.
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• For Linux, Booklet Layout is on the Layout tab.

• For Macintosh, in the Print window, in Xerox Features, Booklet Layout is on the Paper/Output list.

• For Windows, Booklet Layout is on the Page Layout tab. Page Layout is on the Document Options
tab.

When you print booklets using the Windows PostScript or Macintosh print driver, you can specify the
gutter and creep.

• Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm
(1/72 in.).

• Creep: Specifies how much the page image shifts outward in tenths of a point. Shifting
compensates for the thickness of the folded paper, which can cause the page image to shift
outward slightly when folded. You can select a value from 0–1 point.

Gutter Creep

PPrriinnttiinngg CCoovveerr PPaaggeess
A cover page is the first or last page of a document. You can select paper sources for the cover pages
that are different from the source used for the body of a document. For example, you can use your
company letterhead for the first page of a document. You can use heavyweight paper for the first and
last pages of a report. You can use any applicable paper tray as the source for printing cover pages.

Note: In Linux, you can add covers, inserts, set up exceptions, and print covers. The cover
options are located under the Special Pages tab.

1. To access the cover pages in the print driver window, click Printing Options→Paper→Covers.

2. Select one of these page options for printing cover pages:
• No Covers: This option does not print cover pages. No cover pages are added to the

document.
• Front Only: This option prints the first page on paper from the specified tray.
• Back Only: This option prints the back page on paper from the specified tray.
• Front and Back: Same: This option prints the front and back cover pages from the same tray.

3. Select the paper for the cover pages by size, color, or type.

Note: You can use blank or pre-printed paper, and you can print side one, side two, or both
sides of the cover pages.
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PPrriinnttiinngg WWaatteerrmmaarrkkss ffrroomm WWiinnddoowwss
A watermark is special-purpose text that can be printed across one or more pages. For example, add a
word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before
distribution.

Note: This feature is only available on a Windows computer printing to a network printer.
To print a watermark:

1. In the print driver, click the Document Options tab.

2. Click theWatermark tab.

3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or
create a customized watermark. You can manage watermarks from this menu.

4. For Custom, select an option:
• Text: Enter the text in the field, then specify the font.
• Time Stamp: Specify the date and time options, then specify the font.
• Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark.
• To define the location of the image on the page, specify the position option. Use the Arrows

to move the image in each direction in increments of 1.
• For Picture Option: To define the size of the picture in relation to the original image, specify

the size option. Use the Arrows to scale the image in increments of 1%.
• For Text and Time Stamp Options: To define the angle of the image on the page, specify the

position option. Use the Arrows to rotate the image left or right by increments of 1.

6. For Layering, select how to print the watermark.
• Print in Background: This option prints the watermark behind the text and graphics in the

document.
• Blend: This option combines the watermark with the text and graphics in the document. A

blended watermark is translucent, so you can see both the watermark and the document
content.

• Print in Foreground: This option prints the watermark over the text and graphics in the
document.

7. Click Pages, then select the pages to print the watermark:
• Print on All Pages: This option prints the watermark on all pages of your document.
• Print on Page 1 Only: This option prints the watermark only on the first page of the

document.

8. If you select a picture as a watermark, specify the lightness settings for the image.

9. Click OK.

SSeelleeccttiinngg PPrriinntt OOrriieennttaattiioonn
Orientation allows you to select the direction that the page prints.

• For Linux, the Orientation options are located under the Layout tab.

• For Macintosh, Orientation options are in the Print window.

• For Windows, the Orientation tab is on the Document Options tab.

Note: The orientation setting in your application print dialog box can override the
orientation options in the print driver.
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The following options are available:

• Portrait: This option orients the paper so that the text and images print across the short
dimension of the paper.

• Landscape: This option orients the paper so that the text and images print across the long
dimension of the paper.

Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto
Rotate check box, if available.
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Using Custom Paper Sizes
You can print on custom paper sizes that are within the minimum and maximum size range supported
by the printer. For details, refer to Supported Custom Paper Sizes.

PPrriinnttiinngg oonn CCuussttoomm--SSiizzeedd PPaappeerr
Note: Before printing on custom-sized paper, define the paper size. At your computer, from the
Printer Properties tab, click Custom Paper Sizes. For details, refer to Defining Custom Paper
Sizes.

PPrriinnttiinngg oonn CCuussttoomm--SSiizzeedd PPaappeerr ffrroomm LLiinnuuxx
Before printing on custom-sized paper, define the customer size in the Xerox® Print UI.

PPrriinnttiinngg oonn CCuussttoomm--SSiizzeedd PPaappeerr ffrroomm MMaacciinnttoosshh
Note: Before printing on custom-size paper, define the custom size in the Printer Properties.

1. Load the custom-size paper in the tray. For details, refer to Loading Paper.

2. In the application, click File→Print.

3. From the Paper Size list, select the custom paper size.

4. Click Print.

PPrriinnttiinngg oonn CCuussttoomm--SSiizzeedd PPaappeerr ffrroomm WWiinnddoowwss
Note: Before printing on custom-size paper, define the custom paper size in the Printer
Properties tab.

1. Load the custom-size paper in the tray.

2. In your software application, access the print settings, then press CTRL+P.

3. Select your printer from the list, then click Printer Properties.

4. To select your pre-defined custom-size paper, on the Printing Options tab, from the list, click
Paper→Other Size→Fit to New Paper Size.

5. Select the other printing options as needed, then click OK.

6. In the Print window, click Print.

DDeeffiinniinngg CCuussttoomm PPaappeerr SSiizzeess
To print custom paper sizes, define the custom width and length of the paper. You can define custom
sizes in the print driver software, or at the printer control panel. When you set the paper size, ensure
that you specify the same size as the paper in the tray. Setting the wrong size paper can cause a
printer error. When you print using the print driver software on your computer, print driver settings
override control panel settings.
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CCrreeaattiinngg aanndd SSaavviinngg CCuussttoomm PPaappeerr SSiizzeess iinn tthhee PPrriinntt DDrriivveerr
You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the
print driver and are available for you to select in all your applications.
For more information on supported paper sizes for each tray, refer to Supported Custom Paper Sizes.

Creating and Saving Custom Paper Sizes for Windows
1. In the software application, click File→Print, then select your printer.

2. In the Print window, click Printer Properties, then click Printing Options tab.

3. For Paper, click the arrow, then select Other Size→Advanced Paper Size→Output Paper
Size→New.

4. In the New Custom Paper Size window, enter the height and width of the new paper size.

5. To specify the units of measurement, at the bottom of the window, click the Units button, then
select Inches orMillimeters.

6. To save, in the Name field, type a title for the new size, then click OK.

Creating and Saving Custom Paper Sizes for Macintosh
1. In the software application, click File→Print.

2. Click Paper Size, then selectManage Custom Sizes.

3. To add a custom paper size, in the Manage Paper Sizes window, click the Plus (+) icon.

4. Double-click Untitled, then type a name for the new custom paper size.

5. Enter the height and width of the new custom paper size.

6. For the Non-Printable Area field, click the arrow. From the list, select your printer. For User Defined
margins, set the top, bottom, right, and left margins.

7. To save the settings, click OK.

DDeeffiinniinngg aa CCuussttoomm PPaappeerr SSiizzee aatt tthhee PPrriinntteerr CCoonnttrrooll PPaanneell
You can print custom-sized paper from any paper tray.

1. Add custom-sized paper to the paper tray.

2. Touch the current paper-size setting. From the list, touch Custom.

3. From the list, touch Custom.

4. In the Custom Paper Size screen, enter the height and width of the new paper size.

5. To save the setting, touch OK.

6. Touch Confirm.
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Supported Paper
Your printer is designed to use various paper and other media types. To ensure the best print quality
and to avoid jams, follow the guidelines in this section.
For best results, use Xerox paper and media recommended for your printer.

OOrrddeerriinngg PPaappeerr
To order paper or other media, contact your local reseller or visit www.xerox.com/office/B1022_
B1025supplies.

GGeenneerraall PPaappeerr LLooaaddiinngg GGuuiiddeelliinneess
• Fan paper before loading it in the paper tray.

• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.

• Adjust the paper guides to fit the paper size.

• If excessive jams occur, use paper or other approved media from a new package.

Note: This printer does not support printing on labels, envelopes, and transparencies.

PPaappeerr TThhaatt ccaann DDaammaaggee YYoouurr PPrriinntteerr
Caution: Some paper and other media types can cause poor output quality, increased paper
jams, or damage your printer. Do not use the following paper types:

• Carbonless paper

• Embossing paper

• Erasable bond

• Rough or porous paper

• Inkjet paper

• Non-laser glossy or coated paper

• Paper that has been photocopied

• Folded or wrinkled paper

• Paper with cutouts or perforations

• Stapled paper

• Thermal-Reactive paper

• Envelopes with windows, metal clasps, side seams, or adhesives with release strips

• Padded envelopes

• Plastic media

• Synthetic paper
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Caution: The Xerox® Warranty, Service Agreement, and Xerox® Total Satisfaction Guarantee do
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary
outside these areas. For details, contact your local Xerox® representative.

PPaappeerr SSttoorraaggee GGuuiiddeelliinneess
For optimum print quality, store paper and other media properly.

• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is damaging to
paper.

• Reduce the exposure of paper to strong lights for long periods of time.

• Maintain constant temperatures and relative humidity.

• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to
collect moisture.

• Store paper flat, either on pallets, cartons, shelves, or in cabinets.

• Avoid food or drinks in the area where paper is stored or handled.

• Do not open sealed packages of paper until you are ready to load the paper into the printer.
Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture
loss or gain.

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag
until you are ready to use the media. Keep unused media in the bag and reseal it for protection.

SSuuppppoorrtteedd PPaappeerr TTyyppeess aanndd WWeeiigghhttss

Trays Paper Types Weights

Bypass tray,
Tray 1, and Tray 2 Plain

Letterhead
Pre-printed
Hole-Punched
Lightweight
Heavyweight
Thin Cardstock
Bond
Recycled
Archival
Custom

71–85 g/m2

75–90 g/m2

75–90 g/m2

75–90 g/m2

60–70 g/m2

86–105 g/m2

106–163 g/m2

105–120 g/m2

60–90 g/m2

75–105 g/m2

71–85 g/m2
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SSuuppppoorrtteedd SSttaannddaarrdd PPaappeerr SSiizzeess

Tray Standard Sizes

Bypass tray, Tray 1, and Tray 2 A3 (297 x 420 mm, 11.7 x 16.5 in.) )
A4 (210 x 297 mm, 8.3 x 11.7 in.)
A5 (148 x 210 mm, 5.8 x 8.3 in.)
B4 (257 x 364 mm, 10.1 x 14.3 in.)
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.)
Letter (216 x 279 mm, 8.5 x 11 in.)
Legal (216 x 356 mm, 8.5 x 14 in.)
Oficio (216 x 340 mm, 8.5 x 13.4 in.)
Folio (216 x 330 mm, 8.5 x 13 in.)
Executive (184 x 267 mm, 7.25 x 10.5 in.)
Ledger (432 x 279 mm, 17 x 11 in.)

Bypass tray only A5 LEF (148 x 210 mm, 5.8 x 8.3 in.)
Postcard (102 x 152 mm; 4 x 6 in.)
Statement (140 x 216 mm, 5.5 x 8.5 in.)

SSuuppppoorrtteedd CCuussttoomm PPaappeerr SSiizzeess

Tray Width Length

Bypass tray 125–297 mm (4.9–11.7 in.) 102–432 mm (4.0–17 in.)

Tray 1 and Tray 2 148–297 mm (5.8–11.7 in.) 182–432 mm (7.2–17 in.)

Custom Duplex
130–297 mm (5.1–11.7 in.)

182 – 432 mm (7.2–17 in.)

SSuuppppoorrtteedd PPaappeerr TTyyppeess aanndd WWeeiigghhttss ffoorr AAuuttoommaattiicc 22--
SSiiddeedd PPrriinnttiinngg

Paper Types Weights

Lightweight 60–70 g/m2

Recycled 60–90 g/m2

Plain
Letterhead
Hole-Punched
Pre-printed

71–90 g/m2

Heavyweight 86–110 g/m2
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Paper Types Weights

Bond 105–120 g/m2

Thin Cardstock 111–140 g/m2

SSuuppppoorrtteedd SSttaannddaarrdd PPaappeerr SSiizzeess ffoorr AAuuttoommaattiicc 22--
SSiiddeedd PPrriinnttiinngg

Standard Sizes Dimensions

A4 210 x 297 mm (8.3 x 11.7 in.)

A5 (SEF or Short-Edge Feed) 148 x 210 mm (5.8 x 8.4 in.)

A3 297 x 420 mm (11.7 x 16.5 in.)

B4 257 x 364 mm (10.1 x 14.3 in.)

B5
(JIS or Japanese Industrial Standards)

182 x 257 mm (7.2 x 10.1 in.)

Ledger 432 x 279 mm (17 x 11 in.)

Letter 216 x 279 mm (8.5 x 11 in.)

Legal 216 x 356 mm (8.5 x 14 in.)

Folio 216 x 330 mm (8.5 x 13 in.)

Oficio 216 x 340 mm (8.5 x 13.4 in.)

Executive 184 x 267 mm (7.25 x 10.5 in.)

Statement SEF 140 x 216 mm (5.5 x 8.5 in.)
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SSuuppppoorrtteedd CCuussttoomm PPaappeerr SSiizzeess ffoorr AAuuttoommaattiicc 22--SSiiddeedd
PPrriinnttiinngg
Source Media Types Sizes Weight

Tray 1 or Tray 2 Plain, Lightweight,
Heavyweight, Bond, Thin
Cardstock, Recycled, Archive,
Hole-Punched, Pre-Printed,
Letterhead

A4, Letter, Legal,
Executive, Folio, Oficio, JIS
B5, A5 SEF, Ledger, A3, B4

60–140 g/m2

(16 lb. Bond to 100 lb. Text)

Bypass tray Plain, Lightweight,
Heavyweight, Bond, Thin
Cardstock, Pre-Printed,
Recycled, Archive

A4, Letter, Legal,
Executive, Folio, Oficio, JIS
B5, A5 SEF, Statement
SEF, Ledger, A3, B4

60–140 g/m2

(16 lb. Bond to 100 lb. Text)

Custom Minimum: 130 x 182 mm
(5.1 x 7.2 in.)
Maximum: (297 x 432
mm (11.7 x 17 in.)
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Loading Paper

LLooaaddiinngg PPaappeerr iinn TTrraayy 11
Tray 1 holds a maximum of 250 sheets.
To load paper in Tray 1:

1. Pull out the tray and remove it from the printer.

2. Move out the length and width paper guides

a. Pinch the paper guide levers on both guides.

b. Slide out the paper guides until they stop.

c. Release the paper guide levers.
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3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

4. Load the paper into the tray, then adjust the paper guides in the tray to match the size of the
paper.

• Load paper into the tray with the print side face down.

• Load hole-punched paper with the holes toward the right side of the printer.

• Do not load paper above the maximum fill line. Overfilling can cause paper jams.

5. Slide the tray into the printer, then push the tray in all the way.

6. When the control panel Paper Settings screen prompts you, verify the paper size, type, and color.

7. Change the paper size, type, or color, if necessary.

8. Touch Confirm.
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LLooaaddiinngg PPaappeerr iinn tthhee OOppttiioonnaall TTrraayy 22
Tray 2 is an optional tray that holds a maximum of 250 sheets.
To load paper in Tray 2:

1. To remove the printer tray, grasp the notched area at the bottom of the tray, then pull the tray
toward you.

2. Move out the length and width paper guides

a. Pinch the paper guide levers on both guides.

b. Slide out the paper guides until they stop.

c. Release the paper guide levers.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.
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4. Load the paper into the tray, then adjust the paper guides in the tray to match the size of the
paper.

• Load paper into the tray with the print side face down.

• Load hole-punched paper with the holes toward the right side of the printer.

• Do not load paper above the maximum fill line. Overfilling can cause paper jams.

5. Slide the tray into the printer, then push the tray in all the way.

6. When the control panel Paper Settings screen prompts you, verify the paper size, type, and color.

7. Change the paper size, type or color, if necessary.

8. Touch Confirm.
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LLooaaddiinngg PPaappeerr iinn tthhee BByyppaassss TTrraayy
The bypass tray holds a maximum of 100 sheets.
To load paper in the bypass tray:

1. Open the bypass tray.

Note: If the bypass tray is open and loaded with paper, remove any paper that is a
different size or type.

a. To open the bypass tray, press the release lever.

b. Fully extend the bypass tray.

2. Move out the length and width paper guides, then press down the metal plate near the feed area.

Note: The metal plate is part of the tray near the feeder roll.
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3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from the packaging until you are
ready to use it.
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4. Load the paper in the tray, then adjust the width guides until they touch the edges of the paper.

Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.
• Load hole-punched paper with the holes toward the back of the printer.

• To load letterhead or pre-printed paper, place the letterhead face down with the top edge of
the paper entering the printer first.

Note: These instructions for loading the paper apply to 1-sided and 2-sided printing.
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5. When the control panel Paper Settings screen prompts you, verify the paper size, type, and color.

6. Change the paper size, type or color, if necessary.

7. Touch Confirm.
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Cleaning the Printer

GGeenneerraall PPrreeccaauuttiioonnss
Caution:When cleaning your printer, do not use organic or strong chemical solvents or aerosol
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as
directed in this documentation.

WARNING: Keep all cleaning materials out of the reach of children.

WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized
sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of
pressurized spray cleaners increases the risk of fire and explosion.

Caution: Do not remove the covers or guards that are fastened with screws. You cannot
maintain or service any parts that are behind these covers and guards. Do not attempt any
maintenance procedure that is not described in the documentation supplied with your printer.

WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are
open.

• Do not place anything on top of the printer.

• Do not open covers and doors during printing.

• Do not tilt the printer while it is in use.

• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the
print quality to deteriorate.

• Ensure that any parts removed during cleaning are replaced before you plug in the printer.

CClleeaanniinngg tthhee EExxtteerriioorr
Clean the exterior of the printer once a month.

Caution: Do not spray detergent directly on the printer. Liquid detergent could enter the printer
through a gap and cause problems. Never use cleaning agents other than water or mild
detergent.

To clean the printer exterior:

1. Slightly dampen a soft, lint-free cloth with water.

2. Wipe the paper tray, output tray, control panel, and other exterior areas of the printer.

3. After cleaning, wipe with a dry, lint-free cloth.

Note: For stubborn stains, apply a small amount of mild detergent to the cloth and gently
wipe off the stain.

CClleeaanniinngg tthhee SSccaannnneerr
Clean the scanner once a month, when anything is spilled, or when debris or dust collects on any of
the surfaces. To ensure the best possible copies and scans, keep the feed rollers clean.
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CClleeaanniinngg tthhee DDooccuummeenntt GGllaassss
For best results when scanning and copying documents, keep the document glass as clean as possible.
To clean the document glass:

1. Slightly dampen a soft, lint-free cloth with water.

2. Remove any paper from the document feeder.

3. Open the document cover.

4. Wipe the surface of the document glass until it is clean and dry.

Note: For best results, to remove marks and streaks, use a standard glass cleaner.

5. Wipe the Constant Velocity Transport (CVT) glass until there is no debris, and the glass is clean
and dry.
The CVT glass is the long narrow strip to the left of the document glass.
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6. Wipe the white underside of the document cover until it is clean and dry.

7. Close the document cover.
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Ordering Supplies

WWhheenn ttoo OOrrddeerr SSuupppplliieess
A warning appears on the control panel when the Toner Cartridge or the Drum Cartridge are near
replacement time. Verify that you have replacement cartridges available at your workplace.
To avoid interruptions to your printing, it is important to order these items when the messages first
appear on the control panel. An error message appears on the control panel when the Toner Cartridge
or the Drum Cartridge requires replacement.
Order supplies from your local reseller or go to www.xerox.com/office/B1022_B1025supplies.

Caution: Use of non-Xerox supplies is not recommended. The Xerox® Warranty, Service
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox® supplies
not specified for this printer. The Total Satisfaction Guarantee is available in the United States
and Canada. Coverage could vary outside these areas. For details, contact your Xerox®
representative.

VViieewwiinngg PPrriinntteerr SSuuppppllyy SSttaattuuss
You can check the status of your printer supplies at any time using Xerox® CentreWare Internet
Services or the printer control panel.

Note: To view printer supply status using Xerox® CentreWare® Internet Services, refer to the
System Administrator Guide at www.xerox.com/office/B1022_B1025docs.

To view printer supply status:

1. At the printer control panel, press theMachine Status button.

2. Touch the Supplies option. A listing of supplies status appears.

CCoonnssuummaabblleess
Consumables are printer supplies that deplete during the operation of the printer. The consumable
supplies for this printer are the genuine Xerox® Black Toner Cartridge and the Xerox® Drum Cartridge.

Note:

• When you replace a consumable, refer to the instructions included with the consumable
supply.

• To ensure that print quality, the toner cartridge and drum cartridge are designed to cease
functioning at a predetermined point.

Caution: Use of non-Xerox supplies is not recommended. Use of toner other than genuine
Xerox® Toner can affect print quality and printer reliability. Xerox® Toner is the only toner
designed and manufactured under strict quality controls by Xerox® for use with this specific
printer.

RRoouuttiinnee MMaaiinntteennaannccee IItteemmss
Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.
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Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

• Standard Capacity Toner Cartridge

• Drum Cartridge

Note: Not all options listed are supported on all printers. Some options apply only to specific
printer models or configurations.

TToonneerr CCaarrttrriiddggeess

GGeenneerraall PPrreeccaauuttiioonnss ffoorr tthhee TToonneerr CCaarrttrriiddggee
WARNING:

• When you replace a toner cartridge, be careful not to spill the toner. If any toner spills,
avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner,
have the child spit out the toner, and rinse the mouth with water. Consult a physician
immediately.

• Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills.
Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large
volume of toner, contact your local Xerox® representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can
catch fire and cause burn injuries or an explosion.
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RReeppllaacciinngg aa TToonneerr CCaarrttrriiddggee
When a toner cartridge is almost empty, the control panel displays a toner-low message. When a
toner cartridge is empty, the printer stops and displays a message on the control panel.

1. To open the front of the printer, pull on both sides of the front cover.

2. To release the toner cartridge, push the clips on both sides of the toner cartridge toward each
other.

3. Pull the cartridge straight out toward you.

4. Depending upon the warning message that appears on the control panel, complete one of the
following actions:
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• Replace the toner cartridge with a new cartridge.
• Shake the toner cartridge five or six times to extend the life of the cartridge.

Caution: To prevent spillage of the toner from causing property damage, shake the
toner cartridge over a plastic sheet.

5. To close the printer, push the front cover up, until it clicks into place.

The printer automatically resets.

6. Resend your print job, as needed.

DDrruumm CCaarrttrriiddggeess

GGeenneerraall PPrreeccaauuttiioonnss ffoorr tthhee DDrruumm CCaarrttrriiddggee
Caution: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent
lighting. Do not touch or scratch the surface of the drum cartridge.

Caution: Do not leave the printer covers and doors open for any length of time, especially in
well-lighted places. Light exposure can damage the drum cartridge.

WARNING: Never throw a drum cartridge into an open flame. The cartridge can catch fire and
cause burn injuries or an explosion.

RReeccyycclliinngg SSuupppplliieess
For more information on the Xerox® supplies recycling program, go to www.xerox.com/gwa.
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Moving the Printer
To move the printer:

WARNING:

• To prevent electric shock, never touch the power plug with wet hands.

• When removing the power cord, ensure that you pull the plug and not the cord. Pulling the
cord can result in damage, which can lead to fire or electric shock.

1. Power off the printer.

2. Disconnect the power cord and other cables from the back of the printer. For details, refer to
Powering the Printer On or Off.

3. Remove any paper or other media from the output tray.

4. To prevent possible injury, use two people to lift and carry the printer.

Caution:When moving the printer between locations, do not tilt it more than 10 degrees
to the front, back, left, or right. Tilting the printer more than 10 degrees can cause toner
spillage and the printer to topple.

• Repack the printer and options using the original packing material and boxes or a Xerox
Repackaging Kit. For a repacking kit and instructions, go to www.xerox.com/office/B1022_
B1025support.

• When moving the printer over a long distance, to prevent toner from spilling, remove the
toner cartridge and drum cartridge.

Caution: Failure to repackage the printer properly for shipment can result in damage not
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The
Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage
to the printer caused by improper moving.

5. After moving the printer:

a. Reinstall any parts that you removed.

b. Reconnect the printer to the cables and power cord.

c. Plug in and power on the printer.
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Viewing Billing Meter Information
Billing meter information appears on the Billing Information screen. The impression counts onscreen
are used for billing.
To view billing and usage information:

1. At the printer control panel, press theMachine Status button.

2. To view basic impression counts, touch the Billing Information option.

Note: A page is one side of a sheet of paper. A sheet that has printing on two sides counts
as two impressions.

The serial number of the printer, number of black impressions, number of total impressions, and
the Usage Counters option appear.

3. To view and update all usage counters, touch the Usage Counters option.

4. To select and view any of the counters, use the menu, then select a counter.
• Impression Counters
• Sheet Counters
• Images Sent Counters
• Fax Impression Counters
• All Usage Counters

5. To update counter data to current usage, touch the Update Counters option.
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General Troubleshooting
This section contains procedures to help you locate and resolve problems. You can resolve some
problems by simply restarting the printer.

RReessttaarrttiinngg tthhee PPrriinntteerr
To restart the printer, refer to Powering the Printer On or Off.

Note: If restarting the printer does not resolve the problem, refer to Printer Fails to Power On
and Printer Resets or Powers Off Frequently.

PPrriinntteerr FFaaiillss ttoo PPoowweerr OOnn
Probable Causes Solutions

The printer is not powered on. Power on the printer. For details, refer to Powering the Printer
On or Off.

The power cord is not plugged into the
outlet correctly.

Verify that the printer is powered down, then plug in the
power cord securely into the outlet. For details, refer to
Powering the Printer On or Off.

Something is wrong with the outlet
connected to the printer.

• Plug in a different electrical appliance into the outlet, then
verify that the appliance operates properly.

• Try a different outlet.

The printer is connected to an outlet with a
voltage or frequency that does not match
the printer specifications.

Use a power source within the specifications for the printer.
For details, refer to Powering the Printer On or Off.

Caution: Plug in the three-wire cord with grounding prong directly into a grounded AC outlet.

PPrriinntteerr RReesseettss oorr PPoowweerrss OOffff FFrreeqquueennttllyy

Probable Causes Solutions

The power cord is not plugged into the outlet
correctly.

Power off the printer. Before powering on the printer,
confirm that the power cord is plugged in correctly to
the printer and the outlet.

A system error occurred. Power off the printer, then power it on again. To print
the Error History report, at the printer control panel,
press the Self Help (?) button. Scroll to and select
Error Messages, then touch Print. If the error
persists, contact your Xerox® representative.
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Probable Causes Solutions

The printer is connected to an uninterruptible power
supply.

Power off the printer, then connect the power cord to
a suitable outlet.

The printer is connected to a power strip shared with
other high-power devices.

Plug the printer directly into the outlet or into a
power strip that is not shared with other high-power
devices.

DDooccuummeenntt PPrriinnttss ffrroomm tthhee WWrroonngg TTrraayy

Probable Causes Solutions

An application and print driver have conflicting tray
selections.

1 In the print driver, ensure that you have selected
the correct tray.

2 Access the application from which you are
printing, then go to the page setup or printer
settings.

3 Set the paper source to match the tray selected in
the print driver, or set the paper source to
Automatically Select.

AAuuttoommaattiicc 22--SSiiddeedd PPrriinnttiinngg PPrroobblleemmss

Probable Causes Solutions

Unsupported or incorrect paper. • Ensure that you are using a supported paper size
and weight for 2-sided printing. Do not use 2-
sided printing for envelopes and labels.

Incorrect setting.
In the print driver, for Printer Settings, select Print on
Both Sides.

Note: The setting varies depending on the
application from which you are printing.

PPaappeerr TTrraayy FFaaiillss ttoo CClloossee

Probable Cause Solution

Debris or an object is blocking the paper tray. Remove the debris or object that is blocking the
paper tray.
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PPrriinnttiinngg TTaakkeess TToooo LLoonngg

Probable Causes Solutions

The printer is set to a slower printing mode. For
example, the printer is set to print on Heavyweight
paper.

It takes more time to print on certain types of special
paper. Ensure that the paper type is set properly in
the print driver and at the printer control panel. For
details, refer to Print Speed.

The printer is in power-saver mode. It takes time for printing to start when the printer is
exiting power-saver mode.

The way the printer was installed on the network. Determine if a print spooler or a computer sharing
the printer is buffering all print jobs, then spooling
the jobs to the printer. Spooling can slow print
speeds. To test the speed of the printer, print
information pages, such as the Office Demo Page. If
the page prints at the rated speed of the printer,
check for a network or printer installation issue. For
help, contact the system administrator.

The job is complex. Wait for the document to finish printing.

The print-quality mode in the print driver is set to
Enhanced.

In the print driver, change the print-quality mode to
Standard.

PPrriinntt JJoobb FFaaiillss ttoo PPrriinntt
Probable Causes Solutions

The printer has an error. • To clear the error, power off the printer, then
power it on again.

• If the error persists, contact your Xerox®
representative.

The printer is out of paper. Load paper into the tray.
For details, refer to Loading Paper.

A toner cartridge is empty. Replace the empty toner cartridge.
For details, refer to Toner Cartridges.

The power cord is not plugged into the outlet
correctly.

Power off the printer, then confirm that the power
cord is plugged in correctly to the printer and the
outlet. Power on the printer. For details, refer to
Powering the Printer On or Off. If the error persists,
contact your Xerox® representative.
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Probable Causes Solutions

The printer is busy. • Determine if a previous print job is the problem.
On your computer, to delete all print jobs in the
print queue, you can use the Printer Properties
feature.

• Load paper in the tray.
• At the printer control panel, press the Job Status

button. If the print job is not in the Active Jobs or
Completed Jobs list, check the Ethernet
connection between the printer and computer.
Power off the printer, then power it on again.

• At the printer control panel, press the Job Status
button. If the print job is not in the Active Jobs or
Completed Jobs list, check the USB connection
between the printer and computer. Power off the
printer, then power it on again.

The printer cable is disconnected. • At the printer control panel, press the Job Status
button. If the print job is not in the Active Jobs or
Completed Jobs list, check the Ethernet
connection between the printer and computer.
Power off the printer, then power it on again.

• At the printer control panel, press the Job Status
button. If the print job is not in the Active Jobs or
Completed Jobs list, check the USB connection
between the printer and computer. Power off the
printer, then power it on again.

PPrriinntteerr MMaakkeess UUnnuussuuaall NNooiisseess
Probable Causes Solutions

There is an obstruction or debris inside the printer. 1 Power off the printer.
2 Remove the obstruction or debris.

Note: If you cannot remove the
obstruction or debris, contact your
Xerox® representative.

CCoonnddeennssaattiioonn hhaass FFoorrmmeedd IInnssiiddee tthhee PPrriinntteerr
Moisture can condense inside a printer when the humidity is above 85% or when a cold printer is in a
warm room. Condensation can form in a printer after it has been sitting in a cold room that is heated
quickly.
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Probable Causes Solutions

The printer has been sitting in a cold room. • Before operating the printer, allow it to acclimate
for several hours.

• Allow the printer to operate for several hours at
room temperature.

The relative humidity of the room is too high. • Reduce the humidity in the room.
• Move the printer to a location where the

temperature and relative humidity are within the
operating specifications. For details, refer to
Relative Humidity.

TToonneerr CCaarrttrriiddggee SSttaattuuss MMeessssaaggeess
When a toner cartridge approaches the end of usable life, the control panel displays a toner-low
message. When a toner cartridge is empty, the printer stops and displays a message on the control
panel.

Note: Each new toner cartridge includes installation instructions.

Printer Status Message Cause and Solution

Low Toner Status: Ensure that a new Toner Cartridge
is available.

The toner cartridge is low. Order a new toner
cartridge.

Replace the Toner Cartridge. The toner cartridge is empty. Open the front cover,
then replace the toner cartridge.

DDrruumm CCaarrttrriiddggee SSttaattuuss MMeessssaaggeess
When a drum cartridge approaches the end of usable life, the control panel displays a drum cartridge-
low message. When a drum cartridge is worn, the printer displays an end-of-life message, but the
printer continues to print.

Note: Each new drum cartridge includes installation instructions.

Printer Status Message Cause and Solution

Drum cartridge near end of life. Ensure that a new
drum cartridge is available.

The drum cartridge is nearing end of life. Order a new
drum cartridge.

Drum cartridge is worn. Replace drum cartridge. The drum cartridge requires replacement. Open the
front cover and side cover, then replace the drum
cartridge.
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Paper Jams

MMiinniimmiizziinngg PPaappeerr JJaammss
The printer is designed to function with minimal paper jams using Xerox® supported paper. Other
paper types can cause jams. If supported paper is jamming frequently in one area, clean that area of
the paper path.
The following can cause paper jams:

• Selecting the incorrect paper type in the print driver.

• Using damaged paper.

• Using unsupported paper.

• Loading paper incorrectly.

• Overfilling the tray.

• Adjusting the paper guides improperly.

Most paper jams can be prevented by following a simple set of rules:

• Use only supported paper. For details, refer to Supported Paper.

• Follow proper paper handling and loading techniques.

• Always use clean, undamaged paper.

• Avoid paper that is curled, torn, moist, creased, or folded.

• To separate the sheets before loading into the tray, fan the paper.

• Observe the paper tray fill line. Do not overfill the paper tray.

• After you insert paper in a tray, adjust the paper guides in the tray. A paper guide that is not
properly adjusted can cause poor print quality, misfeeds, skewed prints, and printer damage.

• After you load paper in a tray, at the printer control panel, select the correct paper type and size.

• In the print driver, select the correct paper type and size for the print job.

• Store paper in a dry location.

• Use only Xerox® paper designed for the printer.

Avoid the following:

• Polyester-coated paper that is designed specially for inkjet printers.

• Paper that is folded, wrinkled, or excessively curled.

• Loading more than one type, size, or weight of paper in a tray at the same time.

• Overfilling the trays.

• Allowing the output tray to overfill.
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LLooccaattiinngg PPaappeerr JJaammss
WARNING: To avoid injury, never touch a labeled area on or near the heat roller in the fuser. If
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Power
off the printer immediately, and wait 30 minutes for the fuser to cool. After the printer cools,
try to remove the jammed paper. If the error persists, contact your Xerox® representative.

Caution: Do not attempt to clear any paper jams using tools or instruments. Using tools or
instruments can damage the printer permanently.

The following illustration shows where paper jams can occur along the paper path:

1. Standard Tray 1

2. Optional Tray 2

3. Toner Cartridge and Drum Cartridge Area

4. Document Feeder Top Cover

5. Document Feeder Input Tray

6. Document Feeder Inside Cover

7. Side Cover

8. Bypass Tray

9. Optional Tray 2 Side Cover
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CClleeaarriinngg PPaappeerr JJaammss

CClleeaarriinngg PPaappeerr JJaammss ffrroomm tthhee DDooccuummeenntt FFeeeeddeerr
1. Remove any documents from the document feeder.

2. Open the document feeder top cover.

3. If the paper is jammed in the exit of the document feeder, gently pull out the paper toward you.
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4. If the jammed paper is not caught in the entry of the document feeder, gently pull the paper
upward.

5. If you cannot see the jammed paper, perform the following steps.

a. Open the top cover, then lift the document feeder input tray.

b. Gently pull out the jammed paper toward you.
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c. Lower the document tray.

6. To close the top cover of the document feeder, press down the top cover.

7. To remove jammed paper from the document feeder inside cover, complete the following steps.

a. Lift the document feeder.
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b. Gently pull out any jammed paper.

c. Close the document feeder.

8. Remove any jammed paper from the document feeder input tray.

9. Reload the documents in the document feeder input tray, then adjust the paper guides so that
they touch the edges of the paper.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm TTrraayy 11
To resolve the error that appears on the control panel, clear all jammed paper from the paper path.

Note: If you cannot clear the paper jam by following this procedure, refer to Clearing Paper
Jams from Inside the Printer.

1. To open the side cover of the printer, press the release lever.

2. To remove jammed paper from the side of the printer, pull the jammed paper toward you.

3. To remove jammed paper from Tray 1, pull out the tray until it stops.
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4. To remove jammed paper from Tray 1, gently pull the paper toward you.

5. To close the tray, push it in, toward the printer.

6. If the control panel prompts you, on the Paper Settings screen, verify the paper size, type, and
color.

7. Touch Confirm.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm tthhee OOppttiioonnaall TTrraayy 22
To resolve the error that appears on the control panel, clear all jammed paper from the paper path.

Note: If the jammed paper does not move as you pull it, or if there is no jammed paper in the
optional Tray 2 area, refer to Clearing Paper Jams from Inside the Printer.

1. To open the side cover of the printer, press the release lever.

2. To remove jammed paper from the side of the printer, pull the jammed paper toward you.

3. To remove jammed paper from the optional Tray 2, pull out Tray 2 until it stops.
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4. To remove jammed paper from the optional Tray 2, gently lift the paper and pull it toward you.

5. If the jammed paper does not move when you pull it, or if there is no jammed paper in the
optional Tray 2 area, complete the following steps.

a. Pull out Tray 1.
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b. To remove jammed paper, gently pull up the paper.

c. Push in Tray 1.
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6. Push in the optional Tray 2.

7. Clear jammed paper from the optional Tray 2 side cover:

a. To open the Tray 2 side cover, pull the side cover lever.

b. To remove the jammed paper, gently pull the paper toward you.

8. If the control panel prompts you, in the Paper Settings screen, verify the paper size, type, and
color.

9. Touch Confirm.

CClleeaarriinngg PPaappeerr JJaammss aatt tthhee BByyppaassss TTrraayy
1. To remove jammed paper, pull the paper toward you.

2. If the paper is torn, check inside the printer for pieces of paper, then gently remove them. If you
cannot remove the paper fragments easily, contact your Xerox® representative.

3. When you reload the bypass tray, fan the paper, then ensure that all four corners align neatly.
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4. If the control panel prompts you, on the Paper Settings screen, verify the paper size, type, and
color.

5. Touch Confirm.

CClleeaarriinngg PPaappeerr JJaammss ffrroomm tthhee OOuuttppuutt TTrraayy
1. To clear jammed paper from the output tray area, gently pull the paper toward you.

2. If the paper tears or does not move when you pull it, refer to Clearing Paper Jams from Inside the
Printer.

3. If necessary, to resume printing, follow any remaining instructions on the printer control panel.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm tthhee DDuupplleexx AArreeaa
1. To open the side cover of the printer, press the release lever.

2. To remove jammed paper, gently pull up the paper.

3. If the paper is jammed in the roller, gently lift the roller, then pull the paper toward you.
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4. After you remove all jammed paper, close the side cover.

5. If the control panel prompts you, on the Paper Settings screen, verify the paper size, type, and
color.

6. Touch Confirm.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm IInnssiiddee tthhee PPrriinntteerr
Note: After following this procedure, if you still cannot remove the jammed paper from inside
the printer, contact your Xerox® representative.

1. To open the side cover of the printer, press the release lever.

2. Locate the jammed paper.

a. If you can see the jammed paper, gently pull the paper toward you.

b. If the paper is jammed near the drum cartridge, pull down the paper, then pull it toward you.
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c. If the paper is jammed in the top roller, pull down the fuser gate, then pull the paper toward
you.

d. If the paper is jammed in the transfer roller, gently lift the roller, then pull the paper toward
you.

e. If you cannot remove the jammed paper by pulling the paper toward you, gently pull up the
paper.

Note: If you still cannot remove the jammed paper, contact your Xerox® representative.
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3. After you remove all jammed paper, close the side cover.

4. If the control panel prompts you, on the Paper Settings screen, verify the paper size, type, and
color.

5. Touch Confirm.

TTrroouubblleesshhoooottiinngg PPaappeerr JJaammss

MMuullttiippllee SShheeeettss PPuulllleedd TTooggeetthheerr

Probable Causes Solutions

The paper tray is too full. Remove some of the paper. Do not load paper above
the fill line.

The edges of the paper are not even. Remove the paper, align the edges, then reload the
paper in the tray.

The paper is moist from humidity. Remove the paper from the tray, then replace it with
new, dry paper.

Too much static electricity is present. Load new paper into the printer.

Using unsupported paper. Use only Xerox-approved paper. For details, refer to
Supported Paper.
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PPaappeerr MMiissffeeeeddss

Probable Causes Solutions

The paper is not positioned correctly in the tray. • Remove the misfed paper, then reposition it in the
tray.

• Adjust the paper guides in the tray to match the
size of the paper.

The paper tray is too full. Remove some of the paper. Do not load paper above
the fill line.

The paper guides are not adjusted correctly to the
paper size.

Adjust the paper guides in the tray to match the size
of the paper.

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, then reload it. If
the paper misfeeds, do not use that paper.

The paper is moist from humidity. Remove the moist paper, then replace it with new,
dry paper.

Using paper of the wrong size, thickness, or type. Use only Xerox-approved paper. For details, refer to
Supported Paper.

PPaappeerr JJaamm MMeessssaaggee SSttaayyss OOnn

Probable Causes Solutions

Some paper remains jammed in the printer. Recheck the paper path. Ensure that you have
removed all jammed paper.

One of the printer covers is open. Check the covers on the printer. Close any cover that
is open.

Note: Check for any torn pieces of paper in the paper path, then remove the paper.

JJaammss DDuurriinngg AAuuttoommaattiicc 22--SSiiddeedd PPrriinnttiinngg

Probable Causes Solutions

Using paper of the wrong size, thickness, or type. • Use only Xerox-approved paper.
• For automatic 2-sided printing, do not use reused

paper, damaged paper, or paper heavier than 140
g/m².

Paper is loaded in the wrong tray. Load paper into the correct tray. For details, refer to
Supported Paper.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.
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Print-Quality Problems
Your printer is designed to produce consistently high-quality prints. If you observe print-quality
problems, use the information in this section to troubleshoot the problem. For more information, go
to www.xerox.com/office/B1022_B1025support.

Caution: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee
does not cover damage caused by using unsupported paper or specialty media. The Xerox®
Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary
outside of these areas. For details, contact your local Xerox® representative.

Note: To ensure consistent print quality, the toner cartridges and imaging units are designed to
cease functioning at a predetermined point.

CCoonnttrroolllliinngg PPrriinntt QQuuaalliittyy
Various factors can affect the quality of the output of your printer. For consistent and optimum print
quality, use paper designed for your printer, and set the paper type correctly. To maintain optimum
print quality, follow the guidelines in this section.
Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal
print quality is 10–30º C (50–86º F) and 20–80% relative humidity.

SSoollvviinngg PPrriinntt--QQuuaalliittyy PPrroobblleemmss
When the print quality is poor, select the closest symptom from the following table, then refer to the
corresponding solution. To determine the print-quality problem more precisely, you can print a Demo
Page.
If the print quality does not improve after completing the appropriate action, contact your Xerox®
representative.

Note: To maintain print quality, when toner is low, a warning message appears on the control
panel. When the toner cartridge is empty, the printer stops printing, and a warning message
appears that prompts you to replace the toner cartridge. The printer stops printing until you
install a new toner cartridge.
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Symptom Solutions

The output is too light. • To check the toner level, check the control panel, 
use the print driver, or access Xerox® 

CentreWare® Internet Services. If the toner 
cartridge is almost empty, replace it.

• Verify that the toner cartridge is approved for use
in your printer, then replace the toner, as needed.
For best results, use a genuine Xerox® toner
cartridge.

• Ensure that the print-quality mode is not set to
Toner Saver. The Toner Saver setting is useful for
draft-quality output.

• Replace the paper with a recommended size and
type, then confirm that your printer and print
driver settings are correct.

• Verify that the paper is dry and that supported
paper is used. If not, change the paper.

• Change the Paper Type settings in the print driver.
In the print driver, open the Printing Preferences
menu, click the Paper/Output tab, then change
the Paper Type setting.

• If the printer is located in a high-altitude
environment, adjust the altitude setting of the
printer. For details, refer to the System
Administrator Guide at www.xerox.com/office/
B1022_B1025docs.

Toner smears or the print wipes off.
The output has stains on the back side.

• In the print driver, change the Paper Type
settings. In the print driver, open the Printing
Preferences menu, click the Paper/Output tab,
then change the Paper Type setting. For example,
change Plain to Lightweight Cardstock.

• Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

• Verify that the printer is plugged into an outlet
that provides the correct voltage and power. If
necessary, review with an electrician the electrical
specification of the printer.

• For details, refer to Electrical Specifications.

Random spots appear on the output, or the image is
blurry.

• Ensure that the toner cartridge is installed
correctly.

• Verify that the toner cartridge is approved for use
in the printer, then replace the cartridge, as
needed. For best results, use a genuine Xerox®
toner cartridge.

• Use the Heavyweight or Cardstock paper type
setting, or use a paper type with a smoother
surface.

• Ensure that the humidity in the room is within
specifications. For details, refer to Relative
Humidity.

• For details, refer to Selecting a Location for the
Printer.
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Symptom Solutions

The output is blank. Power off the printer, then power it on again.
If the error persists, contact your Xerox®
representative.

Streaks appear in the output. Order a new Drum Cartridge. To replace the Drum
Cartridge, follow the installation instructions that are
included with the new Drum Cartridge.

The output has a mottled appearance. • Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

• Ensure that the humidity is within specifications.
For details, refer to Selecting a Location for the
Printer.

Ghosting appears in the printed output. • Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

• In the print driver, change the Paper Type
settings. In the print driver, open the Printing
Preferences menu, click the Paper/Output tab,
then change the Paper Type setting.

•
Order a new Drum Cartridge. To replace the Drum
Cartridge, follow the installation instructions that
are included with the new Drum Cartridge.

Auger marks appear on the printed output. • To check the toner level, check the printer control 
panel, use the print driver, or access
Xerox® CentreWare® Internet Services. If the 
toner cartridge is almost empty, replace it.

• Verify that the toner cartridge is approved for use
in your printer, then replace the cartridge, as
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Symptom Solutions

needed. For best results, use a genuine Xerox®
toner cartridge.

•
Order a new Drum Cartridge. To replace the Drum
Cartridge, follow the installation instructions that
are included with the new Drum Cartridge.

The output is wrinkled or stained. • Verify that the paper is the correct size, type, and
weight for the printer and that the paper is
loaded properly. If not, change the paper.

• Load a new ream of paper into the printer.
• In the print driver, change the Paper Type

settings. In the print driver, open the Printing
Preferences menu, click the Paper/Output tab,
then change the Paper Type setting.

The top margin is incorrect. • Verify that the paper is loaded properly.
• Verify that the margins are set correctly in the

application that you are using.
• Verify that the paper orientation is selected

properly in the Paper Settings option on the
printer control panel.
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Copy and Scan Problems
If the copy or scan quality is poor, refer to the following table.

Symptoms Solutions

Lines or streaks are present in copies made from the
document feeder only.

There is debris on the document glass. When
scanning, the paper from the document feeder
passes over the debris, creating lines or streaks. Clean
all glass surfaces with a lint-free cloth.

Spots are present in copies made from the document
glass.

There is debris on the document glass. When
scanning, the debris creates a spot on the image.
Clean all glass surfaces with a lint-free cloth.

The reverse side of the original document appears on
the copy or scan.

Select Background Suppression.

The image is too light or too dark. To lighten or darken the image, use the Lighten/
Darken tab in either the Scan To or Copy function.

If the problem persists, for online support information, go to www.xerox.com/office/B1022_
B1025support
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Fax Problems
Note: If your Xerox device cannot send and receive faxes, ensure that the printer is connected
to an approved analog or digital telephone line.

If your printer cannot send or receive faxes correctly, refer to the following tables.

PPrroobblleemmss SSeennddiinngg FFaaxxeess

Symptoms Causes Solutions

The document is not scanned
using the document feeder.

The document is too thick, too
thin, or too small.

Use the document glass to send
the fax.

The document is scanned at an
angle.

The document feeder guides are
not adjusted to the width of the
document.

Adjust the document feeder
guides to fit the width of the
document.

The fax that the recipient received
is blurry.

The document is positioned
incorrectly.

Position the document correctly.

The document glass is dirty. Clean the document glass.

The text in the document is too
light.

Adjust the resolution. Adjust the
contrast.

There is a problem with the
telephone connection.

Verify that the telephone line is
working, then resend the fax.

There is a problem with the fax
machine of the recipient.

To verify that your printer is
operating correctly, make a copy.
If the copy prints correctly, request
that the recipient verify the
condition of the receiving fax
machine.

The fax received by the recipient is
blank.

The document was loaded
incorrectly.

• If you use the document
feeder: Place the original
document face up.

• If you use the document glass:
Place the original document
face down.

Fax was not transmitted. The fax number is incorrect. Verify the fax number.

The telephone line is connected
incorrectly.

Verify the telephone line
connection. If there is not a
connection, then connect the
telephone line.

There is a problem with the fax
machine of the recipient.

Contact the recipient.
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Symptoms Causes Solutions

The fax is not installed or is not
enabled.

Verify that the fax is installed and
enabled.

Server Fax is not supported.
No solution.

If the problem persists, for online support information, go to www.xerox.com/office/B1022_
B1025support.

PPrroobblleemmss RReecceeiivviinngg FFaaxxeess

Symptoms Causes Solutions

The received fax is blank. There is a problem with the
telephone connection or with the
fax machine of the sender.

Verify that the printer can create
clean copies. If the printer can
create clean copies, request that
the sender resend the fax.

The sender loaded the pages
incorrectly.

Contact the sender.

The printer answers the call, but
does not accept incoming data.

Not enough printer memory. If the
job contains several graphics, the
printer probably does not have
enough memory. If memory is low,
the printer does not answer.

Delete stored documents and jobs,
then wait for the existing job to
complete. The deletion of stored
documents and jobs increases
available memory.

The received fax size is reduced. The paper supply in the printer
does not match the document size
sent.

Confirm the original size of the
documents. Documents can be
reduced based on the available
paper supply in the printer.

Faxes are not received
automatically.

The printer is set to receive faxes
manually.

Set the printer to automatic
reception.

The printer memory is full. If the paper tray is empty, load
paper, then print the faxes stored
in the memory.

The telephone line is connected
incorrectly.

Verify the telephone line
connection. If there is no
connection, connect the telephone
line.

There is a problem with the fax
machine of the sender.

To verify that your printer is
operating correctly, create a copy.
If the copy prints correctly, request
that the sender verify that the fax
machine is operating correctly.
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If the problem persists, for online support information, go to www.xerox.com/office/B1022_
B1025support
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Getting Help
Xerox® provides automatic diagnostic utilities to help you maintain printer productivity and print
quality.

CCoonnttrrooll PPaanneell MMeessssaaggeess
The printer control panel provides information and troubleshooting help. When a fault or warning
condition occurs, the control panel displays a message informing you of the problem. Often, the
control panel displays an animated graphic showing the location of the problem, such as the location
of a paper jam. For many status and warning messages, the control panel Help feature provides
additional information.

VViieewwiinngg WWaarrnniinngg MMeessssaaggeess oonn tthhee CCoonnttrrooll PPaanneell
When a warning condition occurs, a message appears on the control panel to inform you of the
problem. Warning messages inform you about printer conditions, such as low supplies or open doors,
that require your attention. If more than one warning condition occurs, only one appears on the
control panel.

VViieewwiinngg EErrrroorr aanndd AAlleerrtt MMeessssaaggeess oonn tthhee CCoonnttrrooll PPaanneell
When an error condition occurs, a message appears on the control panel to inform you of the
problem. Error messages warn you about printer conditions that prevent the printer from printing or
degrade printing performance. If more than one error occurs, only one is displayed on the control
panel.
To view a list of the current errors on the control panel:

1. Press theMachine Status button, then touch the Active Messages tab.

2. Touch the Faults and Alertsmenu, then choose an option.
• Faults: This option shows the error messages that affect the operation of the printer and the

corresponding fault codes.
• Alerts: This option shows alert messages regarding the current job status of the printer and

the corresponding alert codes.

UUssiinngg tthhee IInntteeggrraatteedd TTrroouubblleesshhoooottiinngg TToooollss
Your printer has a printable set of reports. Two of them, the Demo Page and the Error Message
Report, can help with troubleshooting certain problems. The Demo Page prints an image to show the
current ability of the printer to print. The Error Message Report prints information on the most recent
printer errors.

SSeettttiinngg AAcccceessss RRiigghhttss ffoorr tthhee CCoonnffiigguurraattiioonn RReeppoorrtt aanndd
IInnffoorrmmaattiioonn PPaaggeess
Contact the system administrator to change user access rights in any of the following ways:

• Prevent the Configuration Report from printing automatically whenever the printer powers on.

• Restrict access rights of some or all users so that they cannot print the Information Pages or the
Configuration Report.
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• Change access rights of some or all users so that they can print the Information Pages or the
Configuration Report.

Note: For details, refer to the System Administrator Guide at www.xerox.com/office/B1022_
B1025docs.

AAcccceessssiinngg aanndd PPrriinnttiinngg tthhee IInnffoorrmmaattiioonn PPaaggeess
To access the full list of information pages for your printer:

1. At the printer control panel, press the Self Help (?) button.

A list of information pages that you can print appears.

2. To scroll the list of available pages, touch and drag your finger up or down the menu. Touch the
required page, then touch Print.

Note: To print all the information pages, touch All Information Pages, then touch Print.

3. To return to the Home screen, touch (X).

AAvvaaiillaabbllee IInnffoorrmmaattiioonn PPaaggeess
Information pages provide important details to help you troubleshoot issues or analyze printer use.
You can print information pages from the printer control panel.

Information Page Description

Configuration Report The Configuration Report provides product
information including installed options, network
settings, port setup, tray information, and more.

Customer Assistance Report The Customer Assistance Report provides a summary
of relevant information that you can provide to a
Xerox® support representative.

Demo Page The Demo page provides a demonstration of the
current print quality.

Supplies Usage Report The Supplies Usage Report provides print coverage
information.

Email Sent Report The Email Sent Report provides a record of emails
sent, including From, To, Date & Time, Subject, and
Result.

Error Message Report The Error Message Report provides a record of errors,
including fault and alert codes, and the date and
time of the error.

Fax Broadcast Report The Fax Broadcast Report provides a record of
broadcast faxes, including total pages scanned,
remote station, start time, and result.

Fax Options Report The Fax Options Report displays the current fax
settings.

Fax Phone Book The Fax Phone Book displays a list of names and fax
numbers.
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Information Page Description

Fax Protocol Report The Fax Protocol Report provides fax control field
data, fax information field data, and Send/Receive
information.

Fax Receive Report The Fax Receive Report provides a record of faxes
received.

Fax Transmission Report The Fax Transmission Report provides a record of
faxes sent.

Group Address Book The Group Address Book displays contents of the
Group Address Book, including group number, group
name, user name, and email address.

Junk Fax Report The Junk Fax Report displays a record of junk faxes
received and the numbers from which they were sent.

Last 40 Error Messages Report The Last 40 Error Messages Report is a log of the last
40 error messages, with number, code, name, date,
and time.

Local Address Book The Local Address Book displays contents of the local
address book.

Pending Jobs Report The Pending Jobs Report provides a record of
pending outbound and inbound jobs.

User Authentication Report The User Authentication Report provides a list of
authenticated users and login IDs.

For information on how to print information pages, refer to Accessing and Printing the Information
Pages.

OOnnlliinnee SSuuppppoorrtt AAssssiissttaanntt
The Online Support Assistant provides instructions and troubleshooting help to solve your printer
problems. For example, you can find solutions for print-quality problems, paper jams, and software
installation issues.
To access the Online Support Assistant, go to www.xerox.com/office/B1022_B1025support.

MMoorree IInnffoorrmmaattiioonn
You can obtain more information about your printer from these sources:

Resource Location

Installation Guide Packaged with the printer and can be downloaded at
www.xerox.com/office/B1022_B1025docs

Other documentation for your printer
www.xerox.com/office/B1022_B1025docs

Technical support information for your
printer, including online technical

www.xerox.com/office/B1022_B1025support
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Resource Location

support, Online Support Assistant, and
print driver downloads.

Information Pages
Accessing and Printing the Information Pages

Information about menus or error
messages

Press the control panel Self Help (?) button.

Order supplies for your printer
http://www.support.xerox.com

Local Sales and Support Center
www.xerox.com/office/worldcontacts

Printer registration
www.xerox.com/office/register

Xerox® Direct online store
www.direct.xerox.com/
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Printer Configurations and Options

AAvvaaiillaabbllee CCoonnffiigguurraattiioonnss
This printer is available in the following standard and optional configurations:

• Standard Configuration – Document Feeder with Tray 1

• Standard Configuration - Document Glass with Tray 1

• Optional Configuration – Document Feeder with Tray 1 and Optional Tray 2

• Optional Configuration – Document Glass with Tray 1 and Optional Tray 2

Note: You can add the optional Wi-Fi Kit or Fax to the standard configurations or any of the
optional configurations.

SSttaannddaarrdd CCoonnffiigguurraattiioonnss

Standard Configuration with Document Feeder and Tray 1
This printer is available in the following standard configurations:

• Local print from personal computer

• Network print

• Scan to email

• Scan to network computer

• Scan to USB and Print from USB mass storage devices

• Copy - includes ID card copy

• Tray 1 with 250-sheet capacity

• Bypass tray with 100-sheet capacity

• Document Feeder

• 2-sided printing

• Xerox® CentreWare® Internet Services

Standard Configuration with Document Glass and Tray 1
All features included in the first standard configuration, except for the document feeder.

OOppttiioonnaall CCoonnffiigguurraattiioonnss
This printer is available in the following optional configurations:

Optional Configuration with Document Feeder
and Optional Tray 2

Optional Configuration with Document Glass
and Optional Tray 2

All features included in the first standard
configuration, plus the optional Tray 2 with 250-
sheet capacity.

All features included in the first standard
configuration, except for the document feeder. The
optional Tray 2 with 250-sheet capacity is also
included.
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SSttaannddaarrdd FFeeaattuurreess
Print Speed 1-Sided print speed:

• Maximum 25 ppm for A4 (210 x 297 mm)
• Maximum 25 ppm for Letter (8.5 x 11 in.)
2-Sided print speed:
• Maximum 13 ppm for A4 (210 x 297 mm)
• Maximum 13 ppm for Letter (8.5 x 11 in.)

Maximum Print
Resolution

Up to 1200 dpi

Standard Memory
(RAM)

1.5 Gbytes

Flash Memory (ROM) NAND 512 Mbytes

Mass Storage Micro SD card 8 Gbytes

Storage N/A

Paper Capacity • Bypass tray with 100-sheet capacity
• Tray 1 with 250-sheet capacity
• Optional Tray 2 with 250-sheet capacity
• Document Feeder with 100-sheet capacity

Maximum Print Size 297 x 432 mm (11.68 x 17 in.)

Minimum Print Size 125 x 101.6 mm (4.92 x 4 in.)

Copy Speed 1-Sided copy: 25 copies per minute
2-Sided copy: 13 copies per minute

Copy Resolution 600 x 600 dpi

Maximum Copy Size 297 x 432 mm (11.68 x 17 in.)

Document Feeder Duplex Automatic Document Feeder

Document Feeder
Capacity

100 sheets

Scan Resolution
600 x 600 dpi

Simplex Input Speed 30 images per minute

Supported Scanning • USB
• Email
• Local Computer Scan
• Network Computer Scan

Maximum Scan Area • Document Glass: 297 x 432 mm (11.69 x 17 in.)
• Document Feeder: Up to 279 x 432 mm (11 x 17 in.) A3

Email and Scan File
Formats

• JPG
• PDF – single and multi-page
• TIFF – single and multi-page
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Control Panel 109 mm (4.3 in.) LCD touch screen and keypad navigation

Connectivity • Universal Serial Bus (USB 2.0)
• USB Flash drive
• Ethernet 10/100 Base TX, internal
• Optional Wi-Fi

Remote Access Xerox® CentreWare® Internet Services

Fax Speed 33.6 Kbps

Fax Resolution • Standard Resolution: 8 x 3.85 pixels/mm (203 x 98 dpi)
• Fine: 8 x 7.7 pixels/mm (203 x 196 dpi)
• Superfine: 11.8 x 11.8 pixels/mm (300 x 300 dpi)

Compression MH, MR, MMR, JBIG, JPEG

Fax Features Walk-up Fax, LAN Fax, Direct Fax, Fax Forward to Email
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Physical Specifications

WWeeiigghhttss aanndd DDiimmeennssiioonnss
Note: There are two standard configurations and two optional configurations:

• Standard Configuration, Document Feeder with Tray 1

• Standard Configuration, Document Glass with Tray 1

• Optional Configuration, Document Feeder with Tray 1 and Optional Tray 2

• Optional Configuration, Document Glass with Tray 1 and Optional Tray 2

Measurement
Standard Configuration,

Document Feeder with Tray 1
Standard Configuration,

Document Glass with Tray 1

Width 56.0 cm (22.0 in.) 56.0 cm (22 in.)

Depth 59.9 cm (23.6 in.) 55.5 cm (21.9 in.)

Height 50.6 cm (19.9 in.) 41.7 cm (16.4 in.)

Weight 30.4 kg (67 lb.) 25.9 kg (57 lb.)

Measure-
ment

Optional Configuration,
Document Glass with Tray 1

Optional Configuration,
Document Glass with Tray 1 and

Optional Tray 2

Width 56.0 cm (22.0 in.) 56.0 cm (22.0 in.)

Depth 59.9 cm (23.5 in.) 55.5 cm (21.9 in.)

Height 62.5 cm (24.6 in.) 53.6 cm (21.1 in.)

Weight 35.8 kg (78.9 lb.) 31.3 kg (69 lb.)

PPhhyyssiiccaall SSppeecciiffiiccaattiioonnss ffoorr SSttaannddaarrdd CCoonnffiigguurraattiioonn
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CClleeaarraannccee RReeqquuiirreemmeennttss
The figure on the left provides clearance requirements for a printer that is equipped with tray 1. The
figure on the right provides additional clearance requirements for a printer that is equipped with the
optional tray 2.
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Environmental Specifications

TTeemmppeerraattuurree
• Optimum Temperature: 16–30° C (61–86° F)

• Operating Temperature: 10° to 30° C (50° to 86° F)

RReellaattiivvee HHuummiiddiittyy
Minimum–Maximum Humidity Range: 10–90%, less than 90% when in the packaging

• Optimum Humidity: 30–70%

• Operating Humidity: 20–80% Relative Humidity

Note: Under extreme environmental conditions, such as 10° C (50° F) and 85% relative
humidity, defects can occur due to condensation.

EElleevvaattiioonn
For optimum performance, use the printer at elevations below 2500 m (8,202 ft.)
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Electrical Specifications

PPoowweerr SSuuppppllyy VVoollttaaggee aanndd FFrreeqquueennccyy
• Input Voltage: AC 110 V – 127 V (± 10%), AC 220 V – 240V (± 10%)

• Rated Frequency: 50 – 60 Hz (± 3%)

PPoowweerr CCoonnssuummppttiioonn
• Power Saver mode or Sleep mode: Less than 1.5 W

• Continuous printing: Less than 650 W

• Ready or Standby: Less than 80 W
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Performance Specifications

PPrriinntteerr WWaarrmm--UUpp TTiimmeess
• Boot Time: Less than 43 seconds.

• Recovery from low-power mode: Less than 18 seconds.

Note:Warm-up time assumes an ambient temperature of 22º C (89.6° F) at 40% relative
humidity.

PPrriinntt SSppeeeedd
• 1-Sided Print Speed: Up to 25 ppm for A4 (210 x 297 mm) and 25 ppm for Letter (8.5 x 11 in.).

• 2-Sided Print Speed: Up to 13 ppm for A4 (210 x 297 mm) and 13 ppm for Letter (8.5 x 11 in.).

Several factors can affect print speed: print mode, paper size, and paper type.

• Print mode: Standard mode is the fastest print mode. Enhanced mode produces the best-quality
prints, but Enhanced mode is half the speed of Standard mode.

• Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes print the fastest.

• Paper type: Plain paper prints faster than cardstock or heavyweight paper.
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Basic Regulations
Xerox has tested this printer to electromagnetic emission and immunity standards. These standards
are designed to mitigate interference caused or received by this printer in a typical office
environment.

EENNEERRGGYY SSTTAARR®® QQuuaalliiffiieedd PPrroodduucctt
This printer is ENERGY STAR® qualified under the ENERGY STAR Program Requirements
for Imaging Equipment.
The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.
The ENERGY STAR Imaging Equipment Program is a team effort between the United States,
European Union, and Japanese governments and the office equipment industry to promote
energy-efficient copiers, printers, fax, multifunction printers, personal computers, and monitors.
Reducing product energy consumption helps combat smog, acid rain, and long-term changes to
the climate by decreasing the emissions that result from generating electricity.
Xerox ENERGY STAR equipment is preset at the factory. Your printer is delivered with the timer,
for switching to Power Saver Mode from the last copy/print out, set at 1 or 2 minutes. For a more
detailed description, refer to Power Saver Mode.

EEuurrooppeeaann UUnniioonn

The CE mark applied to this printer symbolizes a declaration of conformity by Xerox
with the following applicable Directives of the European Union as of April 16, 2014:
Radio Equipment Directive 2014/53/EU.

Hereby, Xerox declares that the radio equipment model B1022/B1025 is in compliance with Directive
2014/53/EU. The full text of the EU declaration of conformity is available at the following Internet
address: www.xerox.com/environment_europe.
This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or
the environment.

WARNING:

• Changes or modifications to this equipment not specifically approved by the Xerox Corporation
can void the user's authority to operate this equipment.

• External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere with the
operation of this Xerox device. If external radiation from ISM equipment interferes with this
device, contact your Xerox representative for assistance.

• This is a Class A digital device. In a domestic environment, this printer can cause radio frequency
interference, in which case the user can be required to take adequate measures.

• To ensure compliance with European Union regulations, use shielded interface cables.
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EEuurrooppeeaann UUnniioonn LLoott 44 IImmaaggiinngg EEqquuiippmmeenntt
AAggrreeeemmeenntt EEnnvviirroonnmmeennttaall IInnffoorrmmaattiioonn

EEnnvviirroonnmmeennttaall IInnffoorrmmaattiioonn PPrroovviiddiinngg EEnnvviirroonnmmeennttaall SSoolluuttiioonnss aanndd
RReedduucciinngg CCoosstt
The following information assists users and was issued in relation to the European Union (EU) Energy
Related Products Directive. Specifically, it was issued in relation to the Lot 4 study on Imaging
Equipment. This directive requires manufacturers to improve environmental performance of in-scope
devices and supports the EU action plan on energy efficiency.
In-scope devices are Household and Office equipment that meet the following criteria.

• Standard monochrome-format devices with a maximum speed of less than 66 A4 images per
minute

• Standard color-format devices with a maximum speed of less than 51 A4 images per minute

Environmental Benefits of Duplex Printing
Most Xerox products have duplex printing capability, also known as 2-sided printing. This capability
enables you to print on both sides of the paper, reduces paper consumption, and, therefore, the use
of valuable resources.
The Lot 4 Imaging Equipment agreement requires that the 2-sided functionality is auto-enabled on
models greater than or equal to either 40 ppm color, or 45 ppm monochrome. The 2-sided function is
auto-enabled during the setup and print driver installation.
Some Xerox models below these speed bands can be enabled with 2-sided print settings defaulted at
the time of installation. Using the 2-sided function reduces the environmental impact of your work.
However, if you require simplex/1-sided printing, you can change the print settings in the print driver.

Paper Types
This printer can print on both recycled and virgin paper, approved to an environmental stewardship
scheme, which complies with EN12281, or a similar quality standard. In certain applications, use
lighter weight paper, such as 60 g/m², which contains less raw material and, therefore, saves resources
per print. Check if this lighter weight paper is suitable for your printing needs.

ENERGY STAR – European Union Information
The ENERGY STAR program is a voluntary scheme to promote the development and purchase of
energy-efficient models, which reduces the environmental impact. For details on the ENERGY STAR
program and models qualified to ENERGY STAR, go to www.energystar.gov

Power Consumption and Activation Time
The amount of electricity a printer consumes depends on the way that you use the device. This
printer is designed and configured to enable you to reduce your electricity costs. After the last print,
the device switches to Ready mode. In this mode, the device can print again immediately. If the
printer is not used for a specified time, the device switches to a Power Saver mode. In these modes, to
enable reduced printer power consumption, only essential functions remain active.
The printer takes slightly longer to produce the first print after it exits a Power Saver mode than it
takes in Ready mode. This delay is due to the system waking up from a Power Saver mode, and is
typical of most imaging devices on the market.
You can set a longer activation time or completely deactivate the Power Saver mode. This device can
take longer to switch to a lower energy level.
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For more information about Xerox participation in sustainability initiatives, go to: www.xerox.co.uk/
about-xerox/environment/engb.html.

Environmental Choice Certified to Office Devices CCD-035

This printer is certified to the Environmental Choice standard for office devices,
meeting all requirements for reduced environmental impact. As part of achieving
certification, Xerox Corporation has proven this product meets the Environmental
Choice criteria for energy efficiency. Certified copier, printer, multifunctional
device, and fax products are required to meet criteria, such as reduced chemical
emissions, and demonstrate compatibility with recycled supplies. Environmental
Choice was established in 1988 to help consumers find printers and services with
reduced environmental impact. Environmental Choice is a voluntary, multi-
attribute, and lifecycle-based environmental certification. This certification
indicates that a product has undergone rigorous scientific testing, exhaustive
testing, or both, to prove its compliance with stringent, third-party, environmental
performance standards.

EEuurraassiiaann EEccoonnoommiicc CCoommmmuunniittyy CCeerrttiiffiiccaattiioonn

Russia, Belarus, and Kazakhstan are working to establish a common customs union,
the Eurasian Economic Community, or EurAsEC. The Eurasian Economic Community
members anticipate sharing a common regulatory scheme and common EurAsEC
certification mark, the EAC Mark.

GGeerrmmaannyy

GGeerrmmaannyy -- BBlluuee AAnnggeell

RAL, the German Institute for Quality Assurance and Labeling, has awarded this
device the Blue Angel Environmental Label. This label distinguishes it as a device
that satisfies Blue Angel criteria for environmental acceptability in terms of
device design, manufacture, and operation. For more information, go to: www.
blauer-engel.de.

BBlleennddsscchhuuttzz
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert werden.

LLäärrmmeemmiissssiioonn
Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A)
oder weniger gemäß EN ISO 7779.
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IImmppoorrtteeuurr
Xerox GmbH
Hellersbergstraße 2-4
41460 Neuss
Deutschland

TTuurrkkeeyy RRooHHSS RReegguullaattiioonn
In compliance with Article 7 (d), we certify “it is in compliance with the EEEregulation.”
“EEE yönetmeliğine uygundur.”

RReegguullaattoorryy IInnffoorrmmaattiioonn ffoorr 22..44 GGHHzz WWiirreelleessss NNeettwwoorrkk
AAddaapptteerr
This product contains a 2.4-GHz Wireless LAN radio transmitter module that complies with the
requirements specified in European Council Directive 2014/53/EU. Radio Frequency (RF) output
power of this device will not exceed 20 dBm in either frequency band.
Operation of this device is subject to the following two conditions:

1. The device does not cause harmful interference, and

2. This device accepts any interference received, including interference that may cause undesired
operation.

Changes or modifications to this device, not specifically approved by the Xerox Corporation, may void
the user's authority to operate this equipment.
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Copy Regulations

CCooppyy RReegguullaattiioonnss
Copying certain documents may be illegal in your country. Penalties of fine or imprisonment can be
imposed on those individuals found guilty of making such reproductions.

• Currency notes

• Bank notes and checks

• Bank and government bonds and securities

• Passports and identification cards

• Copyright material or trademarks without the consent of the owner

• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. If there is
doubt, contact your legal counsel.
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Fax Regulations

FFaaxx SSeenndd HHeeaaddeerr RReeqquuiirreemmeennttss
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer
or other electronic device, including a fax machine, to send any messages unless such a message
clearly contains in a margin at the top or bottom of each transmitted page, or on the first page of the
transmission, the date and time it is sent, and an identification of the business or other entity, or
other individual sending the message, and the telephone number of the sending machine or such
business, other entity, or individual. The telephone number provided may not be a 900 number or any
other number for which charges exceed local or long-distance transmission charges.

EEuurrooppeeaann UUnniioonn

RRaaddiioo EEqquuiippmmeenntt aanndd TTeelleeccoommmmuunniiccaattiioonnss TTeerrmmiinnaall EEqquuiippmmeenntt
DDiirreeccttiivvee
The Facsimile was approved in accordance with the Council Decision 1999/5/EC for pan-European
single-terminal connection to the public switched telephone network (PSTN). However, due to
differences between the individual PSTNs in different countries, the approval does not assure
successful operation on every PSTN network terminal point.
If a problem occurs, contact your authorized local dealer.
This product was tested and is compliant with ES 203 021-1, -2, -3, a specification for terminal
equipment for use on analog-switched telephone networks in the European Economic Area. This
product provides a user-adjustable setting of the country code. Set the country code before you
connect this product to the network. Refer to the customer documentation for the procedure for
setting the country code.

Note: Although this printer can use either loop disconnect (pulse) or DTMF (tone) signaling,
DTMF signaling is recommended for more reliable and faster call setup. Modification of this
product, connection to external control software, or connection to an external control
apparatus not authorized by Xerox, invalidates its certification.

SSoouutthh AAffrriiccaa FFaaxx RReegguullaattiioonnss
Use this modem with an approved surge-protection device.
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Material Safety Data Sheets
For Material Safety Data information regarding your printer, go to European Union: www.xerox.com/
environment_europe
For the Technical Customer Support phone numbers, go to: www.xerox.com/office/worldcontacts.
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All Countries
If you are managing the disposal of your Xerox product, note that the printer may contain lead,
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental
considerations. The presence of these materials is fully consistent with global regulations applicable
at the time that the product was placed on the market. For recycling and disposal information,
contact your local authorities.

Perchlorate Material

This product may contain one or more Perchlorate-containing devices, such as batteries. Special
handling may apply. Refer to www.dtsc.ca.gov/hazardouswaste/perchlorate.
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European Union
You can use some equipment in both a domestic/household and a professional/business application.

DDoommeessttiicc//HHoouusseehhoolldd EEnnvviirroonnmmeenntt
Application of this symbol on your equipment is confirmation that you cannot
dispose of the equipment in the typical household waste stream.

In accordance with European legislation, you are required to segregate from household waste any
end-of-life electrical and electronic equipment that is subject to disposal.
Private households within EU member states can return used electrical and electronic equipment to
designated collection facilities free of charge. Contact your local disposal authority for information.
In some member states, when you purchase new equipment, your local retailer can take back your old
equipment free of charge. Ask your retailer for information.

PPrrooffeessssiioonnaall//BBuussiinneessss EEnnvviirroonnmmeenntt
When this symbol is on your equipment, you are required to dispose of the equipment
in compliance with agreed national procedures.

In accordance with European legislation, you are required to manage end-of-life electrical and
electronic equipment that is subject to disposal, within agreed procedures.
Before disposal, for end-of-life take-back information, contact your local reseller or Xerox
representative.

BBuussiinneessss UUsseerrss iinn tthhee EEuurrooppeeaann UUnniioonn
To discard electrical and electronic equipment, for further information, contact your dealer or supplier.

DDiissppoossaall OOuuttssiiddee ooff tthhee EEuurrooppeeaann UUnniioonn
These symbols are only valid in the European Union. If you want to discard these items, contact your
local authorities or dealer for the correct method of disposal.

BBaatttteerryy SSyymmbbooll NNoottee

This wheeled-bin symbol may be used in combination with a chemical symbol. This
establishes compliance with the requirements set by the Directive.
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BBaatttteerryy RReemmoovvaall
Use only a manufacturer-approved service facility to replace the batteries.
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Other Countries
To request disposal guidance, contact your local waste-management authority.
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2-Sided Copying
and 2-Sided
Scan

To set the printer to copy or
scan one or both sides of an
original document, use the 2-
Sided options. For Copy or Scan
jobs, you can specify 1-Sided or
2-Sided output. To rotate the
second side pages, use the
Output Rotation option.

X X X X X

Auto Center To center the image within the
document margins, use the Auto
Center setting.

X

Background
Suppression

To reduce the sensitivity of the
printer to variations in light
background colors, use the
Background Suppression setting.

X X X X X X

Book Copying To copy books, magazines, or
other bound documents, use the
Book Copying feature.

X

Booklet
Creation

To print two pages on each side
of the paper, use the Booklet
Creation feature. The pages are
reordered so that they are in
numerical order when folded.

X

Collation You can collate multiple-page
copy jobs automatically. For
example, for three 1-sided
copies of a six-page document,
the copies are printed in this
order:
1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1,
2, 3, 4, 5, 6.

X

Covers You can add a front cover, a
back cover, or front and back
covers to a job. The printer

X
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selects the special paper for the
cover from a different tray. The
cover can be blank or printed.

Delay Send You can set a time in the future
for the printer to send your fax
job. You can delay the send of
your fax job for up to 24 hours.

X

Enter Recipient To enter the fax number of each
recipient, use the touch screen
keypad.

X

File Format To specify the format of the
saved image, use the File
Format option.

X X X

From To specify the originator of the
email or scan, use the From
option.

X

If File Already
Exists

To define the action that the
printer takes to name a file
when the file name is used
already, use this option.

X

Image Shift To modify the location of the
image on the page, use the
Image Shift option. You can
shift the printed image along
the X and Y axes of each sheet
of paper.

X

Lighten/Darken To make the output image or
print lighter or darker, move the
Lighten/Darken slider.

X X X X X X

Mailboxes To store faxes that were
retrieved remotely, use the
Mailboxes option. You can use
this option to store faxes for
retrieval by a remote printer
with faxing capability. The
mailbox number is required to
access a mailbox. You can set a
passcode to secure confidential
documents.

X
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Manual Dial
Mode

To enable the fax modem
speaker temporarily, use the
Manual Dial Mode option. This
feature is helpful to dial
international numbers, or to use
phone systems that require you
to wait for a specific audio tone.

X

Margin Shift To shift the margins on the left,
right, top, or bottom of the
image, use the Margin Shift
settings.

X

Message To enter information to
accompany the email, use the
Message option.

X

Original
Orientation

To specify the layout of the
original images, use the Original
Orientation option. The printer
uses the information to
determine if images require
rotation to produce the required
output.

X X X X X

Original Size To ensure that you are scanning
the correct area of the
documents, specify the original
document size.

X X X X X

Original Type The printer optimizes image
quality based on the type of
images in the original
document, and how the original
was created.

X X X X X

Output Color To control color rendering of the
output image or print, use the
Output Color option.

X X X

Page Layout You can print the selected
number of pages on one side of
a sheet of paper. If you select
multiple pages per sheet, you
save paper, and provide a way
to review the document layout.

X
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Paper Supply To specify the paper tray for
your print job, use the Paper
Supply option. If you select
Auto, the printer chooses the
paper tray based on the original
document size and the selected
settings.

X X

Polling The Polling feature allows you to
store a faxed document on the
printer so that the document is
available to other printers with
the Polling feature. You can
retrieve faxes stored on other
printers equipped with the
Polling feature.

X

Quantity To enter the number of copies
required for your job, use the
Quantity option.

X X X

Reduce/Enlarge You can reduce the image to as
little as 25% of the original size
or enlarge it as much as 400%.

X

Reply To To include an email address that
you want the recipient to reply
to, use the Reply To option. This
option is useful if you want the
recipient to reply to your email
address rather than to the
printer.

Note: The system
administrator can preset
this option.

X

Resolution Resolution determines how fine
or grainy graphic images
appear. Image resolution is
measured in dots per inch (dpi).

X X X X
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Send Header
Text

It is unlawful to send a fax
message without the proper
header text. To ensure that the
following information is included
on all faxes, use the Send
Header Text option:
• Name and telephone

number of the sender
• Date and time of the

transmission

X

Subject To add a title or heading to an
email, use the Subject option.

X
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